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MBA I YEAR I SEM 

R20MBA06 INFORMATION TECHNOLOGY FOR MANAGERS 

 

Course Aim: 

 It helps the students to enhance the knowledge in system applications and to be a technical 

expertise in domain. 

 To create the awareness of technology impact in decision making and its significance in 

business management.  

Learning Outcomes:  
 It provides basic knowledge about software which can aid to advance student’s presentation 

skills by using technological tools like MS-Word, MS-Excel and MS-PowerPoint. 

 To understand the flow of information through various network systems for better 

communication, usage of Smart tools and applications in recent trends. 

 

Unit-I: T Software Concepts 

Software: Types of Software - its Nature and Qualities. 

Operating Systems: Features of Microsoft Windows and Linux - IT importance in Current 

Scenario. 

 

Unit-II: MS Office- Applications  

MS Word in Business Correspondence: Letters - Tables - Mail Merge - Labels.  

Applications of MS Excel: Graphs and Charts - Basic Calculations of various functions in 

Excel. 
 

Unit-III: MS Power Point  

Introduction to MS Power Point: Toolbar - Icons and Commands - Navigating in Power Point 

- Creation of Slides - Animation - Templates - Designing Presentations - Slide Show Controls - 

Making Notes on Pages and Handouts - Printing Presentations - Customizing Presentations - 

Types of Templates. 

 

Unit-IV: Computer Networks  

Overview of Network: Communication Processors - Communication Media - Types of Network 

- Network Topologies - Network Protocols - Network Architecture - Recent Developments - 

Basic Cloud Computing Service Models. 

 

Unit-V: Smart Tools & Apps  

Tools & Apps: Smart Cards - Paytm - On-line payment Apps - Knowledge and Information 

Sharing Apps - Digitisation - IOT - Hot Spot - Features of Artificial Intelligence. 

 

REFERENCES: 

 Sanjay Saxena and Prathpreet Chopra, Computer Applications in Management, Vikas. 

 Aksoy, Introduction to Information Technology, Cengage, ND 

 Parameswaran: Computer Application in Business, S Chand, New Delhi. 

 PS Gill, Database Management Systems, IK Int Pub House, New Delhi 

 D.P. Goyal, Management Information Systems, MacMillan Publishers. 

 Sudalaimuthu & Anthony Raj, Computer Applications in Business, Himalaya, Mumbai 
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Unit-I: Software Concepts 
  

Computer software is programming code executed on a computer processor. The code can be 

machine-level code, or code written for an operating system. An operating system is software 

intended to provide a predictable and dependable layer for other programmers to build other 

software on, which are known as applications. It also provides a dependable layer for hardware 

manufacturers. This standardization creates an efficient environment for programmers to create 

smaller programs, which can be run by millions of computers. Software can also be thought of as 

an expression that contrasts with hardware. The physical components of a computer are the 

hardware; the digital programs running on the hardware are the software. Software can also be 

updated or replaced much easier than hardware. Additionally, software can be distributed to a 

number of hardware receivers. Basically, software is the computer logic computer users interact 

with. 

Two Basic Examples 

A machine-level example of software is Basic Input/output System, or BIOS. When you start the 

computer, the BIOS loads and runs before your hard drive even connects. The BIOS checks 

connection to hardware and looks for the operating system to load. You can upgrade the BIOS 

by flashing, which is when you replace machine-level software stored on the main board of your 

computer. 

Types of software 

There are three types of software: 

 System Software 

 Application Software 

 Utility Software (most of the people include this as a sub-category of application 

software) 

System Software System software is a collection of one or more programs used to control and 

coordinate the hardware and other application software. Generally the system software may 

perform the following functions: 

Communicates with hardware devices: Controls and monitors the proper use of various 

hardware resources like CPU, memory, peripheral devices like monitor, printer etc. 

Supports the execution and development of other application software. 

Few examples of system software are: 

Operating system 

 Programming language translators 

 Communication software 

 Compiler and Interpreters 

 Command line shell 

Application Software 

Application software is a collection of one or more programs used to solve a specific task. 
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Generally software used in banking industry, airline/railway reservation, generation of telephone 

or electricity bills etc. all fall under application software. 

Few examples of application software are: 

Word processing software 

Spreadsheet software 

Database software 

Education software 

Entertainment software 

Utility Software 

Utility software is a collection of one or more programs that helps the user in system 

maintenance tasks and in performing tasks of routine nature. Utility programs help the users in 

disk formatting, data compression, data backup, scanning for viruses etc. 

Few examples of utility software are: 

Anti-virus 

Registry cleaners 

Disk defragmenters 

Data backup utility 

Disk cleaners 

Features and qualities of software: 

 Flexibility and Extensibility:  

Flexibility is the ability of software to add/modify/remove functionality without 

damaging current system. Extensibility is the ability of software to add functionality 

without damaging system, so it may be thought as a subset of flexibility. Those 

functionality changes may occur acoording to changing requirements, or an obligation if 

development process is one of the iterative methods. Change is inevitable in software 

development and so, this is one of the most important properties of quality software 

 Maintainability and Readability 

Maintainability is a little similar with flexibility but it focuses on modifications about 

error corrections and minor function modifications, not major functional extensibilities. It 

can be supported with useful interface definitions, documentations and also self-

documenting code and/or code documentation. The more correct and useful 

documentation exists, the more maintainability can be performed. 

 Performance and Efficiency 

Performance is mostly about response time of the software. This response time should be 

in acceptable intervals (e.g. max. a few seconds), and should not increase if transaction 

count increases. And also, resources are expensive. Efficiency must be supported with 

resource utilization. As an exaggerated example, ability of performing a simple function 

only by using a 32 processor machine or 1 TB disk space is not acceptable. Optimal 

source/performance ratio must be aimed.  
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 Scalability 

A scalable system responds user actions in an acceptable amount of time, even if load 

increases. Of course more hardware may be added for handling increasing user 

transaction, but the architecture should not change while doing this. This is called vertical 

scalability. Ability of running on multiple, increasing count of machines is multiple 

processing. If the software can perform that type of processing, this is called horizontal 

scalability. A preferred scalable system should suit both of these methods. 

 Availability, Robustness, Fault Tolerance and Reliability: 

A robust software should not lose its availability even in most failure states. Even if some 

components are broken down, it may continue running. Besides, even if whole 

application crashes, it may recover itself using backup hardware and data with fault 

tolerance approaches. There should always be B and even C, D plans. Reliability also 

stands for the integrity and consistency of the software even under high load conditions. 

So it is relevant with availability and scalability. An unreliable system is also unsalable. 

 Usability and Accessibility 

User interfaces are the only visible parts of software according to the viewpoint of user. 

So, simplicity, taking less time to complete a job, fast learn ability etc. is very important 

in this case. The most well known principle for this property is KISS (Keep It Simple 

Stupid). Simple is always the best. A usable software should also support different 

accessibility types of control for people with disabilities. 

 Platform Compatibility and Portability 

A quality software should run on as much various platforms as it can. So, more people 

can make use of it. In different contexts we may mention different platforms, this may be 

OS platforms, browser types etc. And portability is about adapting software that can run 

on different platforms, for being more platform compatible. In this sense, portability is 

also related with flexibility 

 Testability and Manageability 

Quality software requires quality testing. Source code should be tested with the most 

coverage and with the most efficient testing methods. This can be performed by 

using encapsulation, interfaces, patterns, low coupling etc. techniques correctly. Besides 

testability, a qualified software should be manageable after deployment. It may be 

monitored for e.g. performance or data usage status, or may enable developer to 

configure system easily. Creating a successful logging system is another very important 

issue about manageability. 

 Security 

Security is a very important issue on software development, especially for web or mobile 

based ones which may have millions of users with the ability of remote accessing to 

system. You should construct a security policy and apply it correctly by leaving no entry 

points. This may include authorization and authentication techniques, network attack 

protections, data encryption and so on. all possible types of security leaks should be 
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considered, otherwise one day only one attack may crash your whole applicaion and 

whole company. 

 Functionality and Correctness 

Functionality (or correctness) is the conformity of the software with actual requirements 

and specifications. In fact this is the precendition attribute of an application, and maybe 

not a quality factor but we wanted to point that as the last quality factor, for taking 

attention: Quality factors are not meaningful when we are talking about unfunctional 

software. First, perform desired functionality and produce correct software, then apply 

quality factors on it. If you can perform both paralelly, it is the bes 

Operating system 

An OS is a program that controls the execution of application programs and acts as an interface 

between applications and the computer hardware. 

 

Objectives of OS: 

Convenience: An OS makes a computer more convenient to use. 

Efficiency: An OS allows the computer system resources to be used in an efficient manner. 

Ability to evolve: An OS should be constructed in such a way as to permit the effective 

development, testing, and introduction of new system functions without interfering with service. 

Functions of OS: 

Program development: 

The OS provides a variety of facilities and services, such as editors and debuggers, to assist the 

programmer in creating programs. 

Typically, these services are in the form of utility programs that, while not strictly part of the 

core of the OS, are supplied with the OS and are referred to as application program development 

tools. 

Program execution: 

A number of steps need to be performed to execute a program. Instructions and data must be 

loaded into main memory, I/O devices and files must be initialized, and other resources must be 

prepared. 

The OS handles these scheduling duties for the user. 

Access to I/O devices: 

Each I/O device requires its own peculiar set of instructions or control signals for operation. 
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The OS provides a uniform interface that hides these details so that programmers can access such 

devices using simple reads and writes. 

Controlled access to files: 

For file access, the OS must reflect a detailed understanding of not only the nature of the I/O 

device (disk drive, tape drive) but also the structure of the data contained in the files on the 

storage medium. 

In the case of a system with multiple users, the OS may provide protection mechanisms to 

control access to the files. 

System access: 

For shared or public systems, the OS controls access to the system as a whole and to specific 

system resources. 

The access function must provide protection of resources and data from unauthorized users and 

must resolve conflicts for resource contention. 

Error detection and response: 

A variety of errors can occur while a computer system is running. These include internal and 

external hardware errors, such as a memory error, or a device failure or malfunction; and various 

software errors, such as division by zero, attempt to access forbidden memory location, and 

inability of the OS to grant the request of an application. 

In each case, the OS must provide a response that clears the error condition with the least impact 

on running applications. 

The response may range from ending the program that caused the error, to retrying the operation, 

to simply reporting the error to the application. 

Accounting: 

A good OS will collect usage statistics for various resources and monitor performance 

parameters such as response time. 

On any system, this information is useful in anticipating the need for future enhancements and in 

tuning the system to improve performance. 

On a multiuser system, the information can be used for billing purposes. 

Besides the above functions an operating system can perform the following functions too 

 

Storage Management 

Operating System also Controls the all the Storage Operations means how the data or files 

will be Stored into the computers and how the Files will be Accessed by the users etc. All the 

Operations those are Responsible for Storing and Accessing the Files is determined by the 

Operating System Operating System also Allows us Creation of Files, Creation of Directories 

and Reading and Writing the data of Files and Directories and also Copy the contents of the Files 

and the Directories from One Place to Another Place.  

1) Process Management : The Operating System also Treats the Process Management means all 

the Processes those are given by the user or the Process those are System ‘s own Process are 

Handled by the Operating System . The Operating System will Create the Priorities foe the user 

http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer


8 
 

and also Start or Stops the Execution of the Process and Also Makes the Child Process after 

dividing the Large Processes into the Small Processes. 

2)   Memory Management: Operating System also Manages the Memory of the Computer 

System means Provide the Memory to the Process and Also Deallocate the Memory from the 

Process. And also defines that if a Process gets completed then this will deallocate the Memory 

from the Processes.  

3)  Extended Machine : Operating System also behaves like an Extended Machine means 

Operating system also Provides us Sharing of Files between Multiple Users, also Provides Some 

Graphical Environments and also Provides Various Languages for Communications and also 

Provides Many Complex Operations like using Many Hardware’s and Software’s. 

 

Features Windows operating system  

1) Windows Easy Transfer: One of the first things you might want to do is to transfer your files 

and settings from your old computer to the brand new computer. You can do this using an Easy 

Transfer Cable, CDs or DVDs, a USB flash drive, a network folder, or an external hard disk.  

You can transfer almost everything from your old computer to the new one. User accounts, Files 

and Folders, Program Settings, Internet Settings and Favorites, E-mail settings, contacts and 

messages. 

 

2) Windows Anytime Upgrade: This feature of Windows Operating System allows you to 

upgrade to any  higher windows version available for your system, so you can take  full 

advantage of enhanced digital entertainment and other features. 

Windows anytime upgrade helps you compare features in each Windows edition and walks you 

through the upgrade process. (Windows 8 being the latest Operating system currently 

available for all the user worldwide). The upgrade will cost you as per the version being 

selected by you. 

 

3) Windows Basics: If you are new to Windows or want to refresh your knowledge about areas 

such as security or working with digital pictures, this features will help you to get started.  

Here you can learn how to help keep your computer more secure, work with digital pictures, use 

the mouse and keyboard, work with files and programs, use email, connect to and explore the 

internet and many more. 

A new user can even see video or animations that will explain the working of the windows 

operating system and will show you step by step instructions in order to configure your pc 

according to your desires. 

 

4) Searching and Organizing: Most folders in Windows have a search box in the upper- right 

corner. To find a file in a folder, type a part of the file name in the search box.  
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You can also use this feature when you don't know where a files is actually located or when you 

want to do an advanced search. Since its will be an indexed searching the results will be very 

quick and very close to your search entries. 

  

5) Parental Controls: Parental Controls give you the means to decide when your children use 

the computer, which website they visit, and which games they are allowed to play. You can also 

get reports of your children's computer activity as well. 

 

6) Ease of Access Center: Ease of Access Center is the place to find and change settings that 

can enhance how you hear, see and use your computer. You can adjust text size and the speed of 

your mouse. This is also where you can go to set up your screen reader and find 

other helpful tools. 

 

7) Default Programs: This is a features of your Windows Operating System where you can 

adjust and set your default programs, associate a file type or a protocol with a program, change 

and set auto play settings, set program access and computer defaults.  

 

8) Remote Desktop Connection: This feature helps a user with a graphical user interface to 

another computer. It is a proprietary protocol developed by Microsoft especially for Windows 

Operating System. Basically by entering the IP address of the other computer you can directly 

see that computer's desktop right on to your desktop normally known as desktop sharing. Using 

this you can share files and data and even solve problem without having physical access to the 

other computer The list just goes through very common and a few features of Windows 

Operating System, but there are many other's which sum up features altogether. 

 

Linux 

Linux is one of popular version of UNIX operating System. It is open source as its source code is 

freely available. It is free to use. Linux was designed considering UNIX compatibility. Its 

functionality list is quite similar to that of UNIX. 

 

Components of Linux System 

Linux Operating System has primarily three components 

 Kernel − Kernel is the core part of Linux. It is responsible for all major activities of this 

operating system. It consists of various modules and it interacts directly with the 

underlying hardware. Kernel provides the required abstraction to hide low level hardware 

details to system or application programs. 

 System Library − System libraries are special functions or programs using which 

application programs or system utilities accesses Kernel's features. These libraries 

implement most of the functionalities of the operating system and do not require kernel 

module's code access rights. 
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 System Utility − System Utility programs are responsible to do specialized, individual 

level tasks. 

 

Kernel Mode vs. User Mode 

Kernel component code executes in a special privileged mode called kernel mode with full 

access to all resources of the computer. This code represents a single process, executes in single 

address space and do not require any context switch and hence is very efficient and fast. Kernel 

runs each process and provides system services to processes, provides protected access to 

hardware to processes. 

Support code which is not required to run in kernel mode is in System Library. User programs 

and other system programs works in User Mode which has no access to system hardware and 

kernel code. User programs/ utilities use System libraries to access Kernel functions to get 

system's low level tasks. 

 

Basic Features 

Following are some of the important features of Linux Operating System. 

 Portable − Portability means software can works on different types of hardware in same 

way. Linux kernel and application programs supports their installation on any kind of 

hardware platform. 

 Open Source − Linux source code is freely available and it is community based 

development project. Multiple teams work in collaboration to enhance the capability of 

Linux operating system and it is continuously evolving. 

 Multi-User − Linux is a multiuser system means multiple users can access system 

resources like memory/ ram/ application programs at same time. 

 Multiprogramming − Linux is a multiprogramming system means multiple applications 

can run at same time. 

 Hierarchical File System − Linux provides a standard file structure in which system 

files/ user files are arranged. 

 Shell − Linux provides a special interpreter program which can be used to execute 

commands of the operating system. It can be used to do various types of operations, call 

application programs. etc. 
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 Security − Linux provides user security using authentication features like password 

protection/ controlled access to specific files/ encryption of data. 

 

Architecture 

The following illustration shows the architecture of a Linux system − 

 

The architecture of a Linux System consists of the following layers – 

Hardware layer − Hardware consists of all peripheral devices (RAM/ HDD/ CPU etc). 

 

Kernel − It is the core component of Operating System, interacts directly with hardware, 

provides low level services to upper layer components. 

 

Shell − An interface to kernel, hiding complexity of kernel's functions from users. The shell 

takes commands from the user and executes kernel's functions. 

 

Utilities − Utility programs that provide the user most of the functionalities of an operating 

systems. 

 

IT importance in Current Scenario 

Information technology (IT) is the application of computers to store, study, retrieve, transmit, 

and manipulate data, or information, often in the context of a business or other enterprise. 

 

The role and importance of information technology in our society is as follows: 

1. Business: With the introduction of computers, the business world was changed forever. Using 

computers and software, businesses use information technology to ensure that their departments 

run smoothly. They use information technology in a number of different departments including 

human resources, finance, manufacturing, and security. 

 

2. Education: Using technology, teachers can prepare their students for a future flooded with 

gadgets including tablets, mobile phones, computers, and so much more. Information technology 

is helping to prevent more high school and college dropouts as well. 
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3. Finance: Without information technology, online purchases would be impossible, and it 

would be impossible for banks to keep these purchases secure. Information technology has also 

made it faster and easier than ever to send or receive money. 

 

4. Healthcare: Improvements in information technology have allowed for great reform in 

healthcare. Most medical offices can now send and receive digital medical information from 

doctors’ you’ve had in the past. Changes like this allow costs to be lowered and increase the 

amount of time doctors can spend on patients compared to paperwork. 

 

5. Security: With so many transactions done online and so much information available online, 

its important to keep all of that safe. Information technology makes it possible for your online 

data to stay secure until accessed by the proper channels. Using passwords and encryption, 

information technology hides your personal digital data away, and the only way it can be 

accessed is by companies who have permission from you. 

 

6. Communication: With improvements in information technology, globalization has increased. 

The world is brought closer, and the world’s economy is quickly becoming a single 

interdependent system. Information can be shared quickly and easily from all over the globe, and 

barriers of linguistic and geographic boundaries can be torn down as people share ideas and 

information with each other. 

 

7. Employment: Information technology has also created new jobs. Programmers, systems 

analyzers, hardware and software developers, and web designers all owe their jobs to 

information technology. Without such advances, these jobs would not exist. 
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Unit-II: MS Office- Applications 
Microsoft Word is a widely used commercial word processor designed by Microsoft. Microsoft 

Word is a component of the Microsoft Office suite of productivity software, but can also be 

purchased as a stand-alone product.  It was initially launched in 1983 and has since been revised 

numerous times. Microsoft Word is available for both Windows and Macintosh operating 

systems.  Microsoft Word is often called simply Word or MS Word. 

Definition: Microsoft Word or MS-WORD (often called Word) is a graphical word processing 

program that users can type with. It is made by the computer company Microsoft. Its purpose is 

to allow users to type and save documents. Similar to other word processors, it has helpful tools 

to make documents. 

Uses of Microsoft Word in Business 

Word may be the word processing powerhouse in Microsoft's Office suite, but the program can 

do more than just put words on paper. It also incorporates desktop publishing, design and data 

handling features, allowing businesses to create many different types of professional documents 

for both internal and external purposes. 

Using Word for Letters and Mailings 

Businesses typically use Word to manage their outgoing correspondence needs. For example, 

you can use the program to create a single letter at a time or to create a mailshot that sends a 

letter to some or all of your customers. Mail merge functions can automatically populate a letter 

template with relevant contact and address information, using databases you create yourself in 

Word or data you import from other Office programs such as Excel or Outlook. Word can also 

print address labels and envelopes. 

Using Word to Create Documents and Forms  

You can use Word to create just about any kind of business document, including company 

reports, presentations, budgets, proposals and plans. It can help you build a library of key forms, 

such as invoices, statements, receipts, memos and agendas. Word's design features are easy to 

use, enabling you to use data visualization tools to add tables, charts and graphs to your 

documents. Its SmartArt function uses graphics to communicate information. 

Using Word to Produce Promotional Materials  

You can use Word to create promotional and marketing materials that you send out to customers 

and prospects. Common options include brochures, flyers and newsletters. Award certificates 

and cards may be useful if you run internal promotions to incentivize your employees. Word can 

also handle stationery design, allowing you to format and produce your own letterheads and even 

business cards. This may be particularly useful for small businesses that may struggle to pay 

third-party design and print costs. 

Using Word to Build Branding  

If you want your employees to use a standardized letter or memo format, you can design one and 

save it as a template that the entire company can use. You can use styles and themes to define 

exactly how all of your business documents will look, giving you a consistency of color, fonts 

and effects. If you prefer, you can download free Microsoft templates. Microsoft groups some 
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templates into style sets, so you could apply the same theme to a range of marketing materials, 

documents and forms, giving you a consistency of branding. 

Format a Professional Business Letter in Word 

1. Launch Microsoft Word. The automatic page default setup is 8.5 inches by 11 inches, which 

probably suits your business letter. If not, click the “Page Layout” tab. Click the “Size” button 

and choose a new paper size. 

2. Type your name and/or job title. Word’s default type of setting, unless you’ve changed it, is 

12 point Times New Roman with single spacing. You can change the formatting in a later step. 

3. Press “Enter” and type the rest of your address. Press “Enter” twice and type the addressee’s 

name and address. 

4. Type the salutation, which will vary by your closeness to or knowledge of the person. Purdue 

University suggests using a person’s full name if you are unsure of his or her gender as well as 

the word “Dear” and a colon. 

5. Type the main portion of the business letter, pressing “Enter” twice between paragraphs to 

leave a line of space. If the body is not automatically left justified, click anywhere on the 

paragraph and click the “Align Left” button on the “Paragraph” section of the “Home” tab’s 

ribbon. 

6. Change the appearance of a single word, phrase, line or paragraph by highlighting it. Use the 

options on the “Home” tab’s ribbon, such as applying a style called “Intense Emphasis” which 

formats the text into italic blue. You can also increase font size, apply boldface, add bullets or 

use different colors to make sections of the business letter stand out, such as a call to action, a 

new product announcement or review of an accomplishment. 

7. Apply a watermark to the letter, ideal for confidential or draft letters, by clicking the “Page 

Layout” tab. Click the “Watermark” button and choose the watermark lettering. This will be 

applied faded behind your letter text, so it will not obscure it. 

8. Click the “Insert” tab. Click “Picture.” Browse to a digital copy of your business logo and 

double-click it. When the graphic is added to the document, click and drag it into place, such as 

in the top-right corner of the letter. 

9. Highlight the bottom of the letter where you typed your name. Click the “Font” menu on the 

“Home” tab and choose a handwriting/script style font such as Bradley Hand, which makes the 

letter look more like you signed it. Another option is to insert a digital signature the same way 

you would insert a business logo. If you left space by pressing the “Enter” key for you to sign 

your name above the typed part, skip this step. 

10. Click the “File” tab. Click “Save As.” Type a name for the business letter file and click the 

“Save” button. 

 

Table Creation 

A table is a structure of vertical columns and horizontal rows with a cell at every intersection. 

Each cell can contain text or graphics, and you can format the table in any way you want. 

Usually the top row in the table is kept as a table header and can be used to put some informative 

instruction. 
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Create a Table 

The following steps will help you understand how to create a table in a Word document. 

 

Step 1 − Click the Insert tab followed by the Table button. This will display a simple grid as 

shown below. When you move your mouse over the grid cells, it makes a table in the table that 

appears in the document. You can make your table having the desired number of rows and 

columns. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 − Click the square representing the lower-right corner of your table, which will create an 

actual table in your document and Word goes in the table design mode. The table design mode 

has many options to work with as shown below. 
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Step 3 − This is an optional step that can be worked out if you want to have a fancy table. Click 

the Table Styles button to display a gallery of table styles. When you move your mouse over any 

of the styles, it shows real time preview of your actual table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 − To select any of the styles, just click the built-in table style and you will see that the 

selected style has been applied on your table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Delete a Table 

Following are the simple steps to delete an existing table from a word document. 

 

Step 1 − Click anywhere in the table you want to delete. 
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Step 2 − Click the Layout tab, and click the Delete Table option under the Delete Table Button to 

delete the complete table from the document along with its content. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mail Merge: 

Mail merge in Microsoft Word allows you to send personalized letters and emails without having 

to customize each letter. You can prepare your document the way you want and add placeholders 

for the various data fields that you want to dynamically fill from a data source. 

 

For example, you can prepare a single letter for all your friends asking how they’re doing but 

with the ability to change the names and cities dynamically in the letter. This way, your generic 

letter to Krishna will mention his name and his city, and the same letter to Rakesh will have 

Rakesh’s name and his city on his letter. 

 

 In a blank Microsoft Word document, click on the Mailings tab, and in the Start Mail 

Merge group, click Start Mail Merge. 

 

 Click Step-by-Step Mail Merge Wizard. 

 

 Select your document type. In this demo we will select Letters. Click Next: Starting 

document. 

 

 Select the starting document. In this demo we will use the current (blank) document. 

Select Use the current document and then click Next: Select recipients. 

 Note that selecting Start from existing document (which we are not doing in this demo) 

changes the view and gives you the option to choose your document. After you choose it, 

the Mail Merge Wizard reverts to Use the current document. 

 

 Select recipients. In this demo we will create a new list, so select Type a new list and then 

click Create. 
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 Create a list by adding data in the New Address List dialog box and clicking OK. 

 Save the list. 

 

 Note that now that a list has been created, the Mail Merge Wizard reverts to Use an 

existing list and you have the option to edit the recipient list. 

 

 Selecting Edit recipient list opens up the Mail Merge Recipients dialog box, where you 

can edit the list and select or unselect records. Click OK to accept the list as is.  

 

 Click Next: Write your letter. 

 

 Write the letter and add custom fields. 

 Click Address block to add the recipients' addresses at the top of the document. 

 

 In the Insert Address Block dialog box, check or uncheck boxes and select options on the 

left until the address appears the way you want it to. 

 

 Note that you can use Match Fields to correct any problems. Clicking Match Fields opens 

up the Match Fields dialog box, in which you can associate the fields from your list with 

the fields required by the wizard. 

 

 Press Enter on your keyboard and click Greeting line... to enter a greeting. 

 

 In the Insert Greeting Line dialog box, choose the greeting line format by clicking the 

drop-down arrows and selecting the options of your choice, and then click OK. 

 

 Note that the address block and greeting line are surrounded by chevrons (« »). Write a 

short letter and click Next: Preview your letters. 

 

 Preview your letter and click Next: Complete the merge. 

 

 Click Print to print your letters or Edit individual letters to further personalize some or all 

of the letters. 

 

Creating Labels: 

 

 Go to Mailings > Labels. 

 Select Options and choose a label vendor and product to use. Select OK. 

 If you don’t see your product number, select New Label and configure a custom label. 

 



19 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Type an address or other information in the Address box (text only). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 To use an address from your contacts list select Insert Address 

 

 To change the formatting, select the text, right-click, and make changes with Font or 

Paragraph. 

 

 Select OK. 

 

 Select Full page of the same label. 

 

 Select Print, or New Document to edit, save and print later. 
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MS Excel: 

Microsoft Excel is a spreadsheet program included in the Microsoft Office suite of applications. 

Spreadsheets present tables of values arranged in rows and columns that can be manipulated 

mathematically using both basic and complex arithmetic operations and functions. 

Definition: Microsoft Excel is a spreadsheet program included in the Microsoft Office suite of 

applications. Spreadsheets present tables of values arranged in rows and columns that can be 

manipulated mathematically using both basic and complex arithmetic operations and functions. 

1) Pivot Tables 

PivotTables summaries large amounts of Excel data from a database that is formatted where the 

first row contains headings and the other rows contain categories or values. The way the data is 

summarized is flexible but usually the Pivot Table will contain values summed over some or all 

of the categories. 

2) Conditional Formatting 

Conditional formatting, as its name suggests, changes the format of a cell dependent on the 

content of the cell, or a range of cells, or another cell or cells in the workbook. Conditional 

formatting helps users to quickly focus on important aspects of a spreadsheet or to highlight 

errors and to identify important patterns in data. 

3) Sorting and Filtering 

Excel spreadsheets help us make sense of large amounts of data. To make it easier to find what 

you need, you can reorder the data or pick out just the data you need, based on parameters you 

set within Excel.  Sorting and filtering your data will save you time and make your spreadsheet 

more effective. 

4) Basic Math 

At the heart of any Excel spreadsheet are the numbers within the data. Using basic math 

functions to manipulate those numbers is one of the features that makes Excel so powerful. 

Simple calculations can be entered into the formula bar in Excel just as they would be written on 

paper. As with all formulae in Excel, start a calculation with the = sign. 

5) Mixed Type Charts 

Mixed type or combo (combination) charts combine two styles of charts, such as Excel’s column 

chart and line chart. This format can be helpful for displaying two different types of information 

or a range of values that varies greatly. 

Excel is used widely in any financially-related activity.  The ability to create new spreadsheets 

where users can define custom formulas to calculate anything from a simple quarterly forecast to 

a full corporate annual report makes Excel highly appealing.  Excel is also used widely for 

common information organization and tracking like a list of sales leads, project status reports, 

contact lists, and invoicing.  Finally, Excel is a useful tool for scientific and statistical analysis 

with large data sets.  Excel's statistical formulas and graphing can help researches perform 

variance analysis, chi-square testing, and chart complex data. 

Excel Formulas You can create simple and complex formulas in Excel to calculate just about 

anything.  Inputs to a formula may be other cells, the results of other formulas, or just straight-
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forward math (5*2+3).  Excel includes a formula library for calculating things like Net Present 

Value (NPV), standard deviation, interest payments over time, and other common financial and 

mathematic formulae. Excel's formula bar includes a feature to help you search for a formula you 

need, and also helps you select the appropriate cells in your workbook to calculate the formula. 

Financial functions  

The excel financial functions have been made available to execute a variety of financial 

calculations, including calculations of yield, investment valuations, interest rates, internal rate of 

return, asset depreciation, and payments. These financial functions can be, however, classified 

into different categories so as to enable you to stumble on the required function. 

There are generally four interrelated quantities that include: 

1. Present Value (PV) equivalent to the value of the load or savings today. This function is used 

to estimate the loan size that could be paid off provided a periodic payment over a provided total 

number of payments and a provided periodic interest rate. 

2. Interest Rate per period (RATE) equivalent to the interest rate, generally monthly. This 

function is used to calculate the periodic interest rate required to pay off a provided present value 

with a provided periodic payment and a total number of payments. 

3. Number of payment periods (NPER) equivalent to number of payment periods. This 

function is used to evaluate the total number of payment periods required to pay off a given 

present value with a provided payment and periodic interest rate. 

4. Periodic payment (PMT) equivalent to the payment per period. This function is used for 

calculating the fixed periodic payment with a given present value, periodic interest rate, and the 

total number of payments. 

If any three of the aforesaid quantities are provided, the fourth one can be calculated easily. 

Excel Financial Functions List: 

LOWER − Converts all characters in a supplied text string to lower case 

UPPER − Converts all characters in a supplied text string to upper case 

TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

CONCATENATE − Joins together two or more text strings. 

LEFT − Returns a specified number of characters from the start of a supplied text string. 

MID − Returns a specified number of characters from the middle of a supplied text string 

RIGHT − Returns a specified number of characters from the end of a supplied text string. 

LEN − Returns the length of a supplied text string 

FIND − Returns the position of a supplied character or text string from within a supplied text 

string (case-sensitive).  

2. Date & Time 

DATE − Returns a date, from a user-supplied year, month and day. 

TIME − Returns a time, from a user-supplied hour, minute and second. 

DATEVALUE − Converts a text string showing a date, to an integer that represents the date in 

Excel's date-time code. 

http://en.wikipedia.org/wiki/Net_present_value
http://en.wikipedia.org/wiki/Net_present_value
http://en.wikipedia.org/wiki/Standard_deviation
https://www.readyratios.com/reference/analysis/internal_rate_of_return_irr.html
https://www.readyratios.com/reference/analysis/internal_rate_of_return_irr.html
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TIMEVALUE − Converts a text string showing a time, to a decimal that represents the time in 

Excel. 

NOW − Returns the current date & time. 

TODAY − Returns today's date. 

 

3. Statistical 

MAX − Returns the largest value from a list of supplied numbers. 

MIN − Returns the smallest value from a list of supplied numbers. 

AVERAGE − Returns the Average of a list of supplied numbers. 

COUNT − Returns the number of numerical values in a supplied set of cells or values. 

COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given criteria. 

SUM − Returns the sum of a supplied list of numbers 

4. Logical 

AND − Tests a number of user-defined conditions and returns TRUE if ALL of the conditions 

evaluate to TRUE, or FALSE otherwise 

OR − Tests a number of user-defined conditions and returns TRUE if ANY of the conditions 

evaluate to TRUE, or FALSE otherwise 

NOT − Returns a logical value that is the opposite of a user supplied logical value or expression 

i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the supplied argument 

is FAL 
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Unit-III: MS Power Point 

PowerPoint is a presentation program developed by Microsoft. It is included in the standard 

Office suite along with Microsoft Word and Excel. The software allows users to create anything 

from basic slide shows to complex presentations. 

PowerPoint is often used to create business presentations, but can also be used for educational or 

informal purposes. The presentations are comprised of slides, which may contain text, images, 

and other media, such as audio clips and movies. Sound effects and animated transitions can also 

be included to add extra appeal to the presentation. However, overusing sound effects and 

transitions will probably do more to annoy your audience than draw their attention. (Yes, we 

have all heard the car screeching noise enough times for one lifetime.) 

Most PowerPoint presentations are created from a template, which includes a background color 

or image, a standard font, and a choice of several slide layouts. Changes to the template can be 

saved to a "master slide," which stores the main slide theme used in the presentation. When 

changes are made to the master slide, such as choosing a new background image, the changes are 

propagated to all the other slides. This keeps a uniform look among all the slides in the 

presentation. 

When presenting a PowerPoint presentation, the presenter may choose to have the slides change 

at preset intervals or may decide to control the flow manually. This can be done using 

the mouse, keyboard, or a remote control. The flow of the presentation can be further customized 

by having slides load completely or one bullet at a time. For example, if the presenter has several 

bullet points on a page, he might have individual points appear when he clicks the mouse. This 

allows more interactivity with the audience and brings greater focus to each point. 

PowerPoint presentations can be created and viewed using Microsoft PowerPoint. They can also 

be imported and exported with Apple Keynote, Apple's presentation program for the Macintosh 

platform. Since most people prefer not to watch presentations on a laptop, PowerPoint 

presentations are often displayed using a projector. Therefore, if you are preparing a PowerPoint 

presentation for a room full of people, just make sure you have the correct video adapter. 

Power point is the most powerful instrument to present your ideas through a pictorial way. The 

following are the important features of power point. 

1. Readymade slides: -Since power point is having powerful wizards, we can prepare the slides 

easily and quickly. The auto content wizard option provides wizards to make the slides easily. 

The template provides a wide range of ready made designs to us. 

2. Background Colours and effects: -We can have a wide variety of background colours for 

slides in power point on addition to colours we can also get different textures and shades in 

slides. We can also change the colour of existing wizards and templates. 

3. Pictures: - Not only captions and different colours we can introduce good pictures either from 

clip art or from scanning the pictures. 

4. Sounds: -Different sounds can be created while presenting the various slides. The sounds will 

have a pleasing effect on the viewers. 

https://techterms.com/definition/excel
https://techterms.com/definition/font
https://techterms.com/definition/mouse
https://techterms.com/definition/keyboard
https://techterms.com/definition/laptop
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5. Animation: -Different animation techniques are also available in the slides. The letters and 

pictures will fly from top to bottom and from left to right. We can have many animating options, 

we can also get preview of various animation effects. 

6. Charts and tables:-We can insert different charts and tables for expressing the data and 

information to the users. The different charts and tables in the MS excel can be easily imported 

into MS power point. 

7. Time for slides: -We can prescribe the time automatically or manually for running and 

exhibiting slides. 

For example we can set the time for 5 or 6 second for each slide to exhibit on the computer. 

8.    Speaker Notes: - Speaker notes are the notes (other features) that can be included in the 

button of the slide so, that new ideas can be discussed during presentation. 

Other Features: - 

MS power point includes many other features like macro’s changing the colors to the slides, font 

etc. We can also change the order of slides using slide sorter view. 

Advantages of power point: - 

There are many advantages of computerized presentation. 

1. The slides can be prepared for different types of audience i.e., literates, illiterates, children, old 

people etc. 

2. They can be run automatically. There is no manual interference for running power point slide 

shows. 

3. There is no problem of getting slides out of order. 

4. We can take print outs of presentation and can be distributed to the audience.  

5. The audience will easily be attracted by the colourful slides with sound and animation 

techniques. 

6. The built in designed templates allow the people to create power full slides very easily. 

7. If we want to change a part of presentation, we need not change all the slides, we can change 

all slides by changing the master slide.  

Tool Bar and Icons 

When you open a PowerPoint document, the ribbon appears as a row of labels, or what we call 

tabs. 

When you go to a tab, the ribbon for that tab opens and you can see the tools and functions that 

were formerly in menus and toolbars in earlier versions of PowerPoint. 

When you see a feature with an arrow  , you can click it to get more information or options. 

You might also notice launchers  at the corner of some of the ribbon’s groups – like in the 

Clipboard and Font groups. Click those to open the dialog box related to that function – the 

launcher on the Font group, for example, opens the Font box, where you set effects such as 

strikethrough, superscript, or character spacing. 
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What’s on the ribbon tabs? 

The ribbon tabs group tools and features together based on their purpose. For example, to make 

your slides look better, look for options on the Design tab. The tools that you use to animate 

things on your slide would be on the Animations tab. 

Here’s a look at what you’ll find in each of the PowerPoint ribbon tabs. 

1. Home 

 

The Home tab holds the Cut and Paste features, Font and Paragraph options, and what you 

need to add and organize slides. 

2. Insert 

 

Click Insert to add something to a slide. This includes pictures, shapes, charts, links, text boxes, 

video and more. 

3. Design 

 

On the Design tab, you can add a theme or color scheme, or format the slide background. 

4. Transitions 

 

Set up how your slides change from one to the next on the Transitions tab. Find a gallery of the 

possible transitions in the Transition to This Slide group – click More  at the side of the 

gallery to see all of them. 

5. Animations 
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Use the Animations tab to choreograph the movement of things on your slides. Note that you 

can see many possible animations in the gallery in the Animation group, and see more of them 

by clicking More. 

6. Slide Show 

 

On the Slide Show tab, set up the way that you want to show your presentation to others. 

7. Review 

The Review tab lets you add comments, run spell-check, or compare one presentation with 

another (such as an earlier version). 

8. View 

 
Views allow you to look at your presentation in different ways, depending on where you are in 

the creation or delivery process. 

9. File 

At one end of the ribbon is the File tab, which you use for the behind-the-scenes stuff you do 

with a file, such as opening, saving, sharing, exporting, printing and managing your presentation. 

Click the File tab to open a new view called the Backstage. 

Click from the list on the side to do what you want to do; for example, click Print to find the 

options and settings for printing your presentation. Click Back   to return to the presentation that 

you were working on. 

10. Tools tabs 
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When you click some parts of your slides, such as pictures, shapes, SmartArt or text boxes, you 

might see a colorful new tab appear. 

 

In the example above, the Drawing Tools tab appears when you click a shape or text box. When 

you click a picture, the Picture Tools tab appears. Other such tabs include SmartArt Tools, Chart 

Tools, Table Tools and Video Tools. These tabs disappear or change when you click something 

else in your presentation. 

 

Navigation in Power Point 

1. Double-click the PowerPoint icon on your desktop or “Start” menu. When PowerPoint opens, 

it provides a blank single slide as the default. To navigate and review an existing PowerPoint 

presentation, click the “File” tab. Click “Open.” Browse to the PPT or PPTX file and double-

click the name. The presentation opens with the title or first slide in the main workspace. 

2. Maximize the PowerPoint workspace by clicking the screen maximize button at the top right 

of the window to the left of the "X" button that closes the program. This is optional, but will 

allow you to see all of PowerPoint in its entirety, including a full view of the essential options 

along the PowerPoint ribbon. 

3. Click the different tabs of the ribbon that run along the top of the PowerPoint workspace. The 

ribbon replaces the PowerPoint toolbars and menus in versions 2007 and forward. Review each 

tab and check the ribbon revealed below it. Notice that the ribbon changes with each tab that is 

clicked and is broken into sections with buttons, drop-down menus and additional options to 

click to navigate throughout PowerPoint. 

4. Review the column running down the left side of the screen. This is the slide deck, which 

gives a smaller pictorial representation of the first few slides in the deck. Use the scroll bar to the 

right of this section to navigate the slides. At any time, double-click a slide in the slide deck to 

jump to that slide, bringing it up in the main portion of the screen. 

5. Scroll the scroll bar in the main portion of the screen to scroll linearly through the slide show. 

You can also press the “Page Up” or “Page Down” keys to scroll slide by slide. 

6. Click the “View” tab. Several options here let you navigate the PowerPoint presentation. Click 

the “Slide Sorter” button on the left side of the ribbon to see a pictorial representation of the 

slides, similar to the slide deck, but one that takes up the entire workspace and lets you see more 

amounts of smaller slides at once. 

7. Click the “Notes Page” slide to navigate through any of the slides you have added speaker 

notes to in a section at the bottom of the main workspace. 



28 
 

8. Click the “Slide Show” tab. Review the options in the “Start Slide Show” section of the left 

side of the ribbon. Several here let you navigate the presentation as well. Click “From 

Beginning” to navigate the slideshow from your first or title slide. While the slideshow runs, you 

navigate it by clicking the back, forward and pause arrows or what you configured during the 

setup. Click either the “From Current Slide” or “Custom Slide Show” buttons to start navigating 

the slideshow from a different slide. 

 

Slide show  

A slide show is a presentation of a series of still images on a projection screen or electronic 

display device, typically in a prearranged sequence. The changes may be automatic and at 

regular intervals or they may be manually controlled by a presenter or the viewer. Slide shows 

originally consisted of a series of individual photographic slides projected onto a screen with 

a slide projector. When referring to the video or computer-based visual equivalent, in which the 

slides are not individual physical objects, the term is often written as one word, slideshow. 

 Customize presentation options and views 

 Changing page setup options 

 Changing to view in color/grayscale 

 Navigating using presentation views 

There are several different views in PowerPoint as we saw earlier and you can navigate through 

the presentation in each in different ways. 

In Normal View 

 Click on the thumbnail of the slide you want to see 

 Use the Vertical Scrollbar to move between slides 

 Use the up and down arrow keys on the keyboard to move one slide backwards or 

forwards 

 In Slide Sorter View 

 Click on the slide you want to select 

 Use the arrow keys to move up, down, left and right 

In Reading View 

Use the next and back icons in the status bar to move back or forwards or use the menu which is 

accessed from the icon in the middle 

PowerPoint's AutoContent wizard gives you a head start on setting up a presentation based on 

various prefab templates. But you can also plug your own presentations into the wizard, making 

it easy to reuse their design, structure, and content. 

The AutoContent Wizard is a great place to start when you're not sure what a presentation should 

cover. This wizard creates a new presentation using built-in templates, offering content ideas to 

help you organize the information you include on each slide. 

What you might not know is that you can add an existing presentation to the AutoContent 

Wizard's library. To do so, follow these steps: 

 Launch the wizard by choosing New from the File menu. 

https://en.wikipedia.org/wiki/Reversal_film
https://en.wikipedia.org/wiki/Projection_screen
https://en.wikipedia.org/wiki/Slide_projector
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 Click the From AutoContent Wizard link in the New Presentation task pane. 

 Click next in the wizard's first pane. 

 Choose the most appropriate content template category from the list and click Add.  
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Unit-IV: Computer Networks 

Communications Processors: 

Communications processors, on the other hand, are generally classed by their range of features, 

flexibility, and capabilities. These include the number and types of host interfaces and protocols 

supported, aggregate bandwidth, and the types of terminal equipment and other devices 

supported.  

A front end processor, or a communications processor, is a small-sized computer which 

interfaces to the host computer a number of networks, such as SNA, or a number of peripheral 

devices, such as terminals, disk units, printers and tape units. 

Establishment Controller 

An establishment or cluster controller manages the activities of a group of printers and terminals, 

allowing them to communicate with the host. 

Network Gateway Processor 

Gateway is a piece of networking hardware used in telecommunications for telecommunications 

networks that allows data to flow from one discrete network to another. Gateways are distinct 

from routers or switches in that they communicate using more than one protocol to connect a 

bunch of networks and can operate at any of the seven layers of the open systems interconnection 

model (OSI). 

Systems Network Architecture (SNA) is IBM's proprietary networking architecture, created in 

1974.It is a complete protocol stack for interconnecting computers and their resources. SNA 

describes formats and protocols and is, in itself, not a piece of software. The implementation of 

SNA takes the form of various communications packages, most notably Virtual 

Telecommunications Access Method (VTAM), the mainframe software package for SNA 

communications. 

Remote Concentrator 

The termination point for all wiring of a common access method into one area is called the 

concentrator. The combination of termination points for different access methods and different 

components is called the hub.  

Gateway Switch 

A gateway switch routes messages among the various network endpoints and provides protocol 

conversion between dissimilar systems, workstations, and networks. 

 

Communication Media 

Communication media refers to the means of delivering and receiving data or information. In 

telecommunication, these means are transmission and storage tools or channels for data storage 

and transmission. 
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Different media are employed for transmitting data from one computer terminal to the central 

computer or to other computer systems inside some kind of network. 

 

There are two forms of communication media: 

Analog: Includes conventional radio, telephonic and television transmissions 

Digital: Computer-mediated communication, computer networking and telegraphy 

The most commonly used data communication media include: 

 Wire pairs 

 Coaxial cable 

 Microwave transmission 

 Communication satellites 

 Fiber optics 

The communication media acts as a channel for linking various computing devices so that they 

may interact with each other. Contemporary communication media facilitate communication and 

data exchange among a large number of individuals across long distances via email, 

teleconferencing, internet forums and many other forms of communication. 

 

A computer network is a set of connected computers. Computers on a network are called nodes. 

The connection between computers can be done via cabling, most commonly the Ethernet cable, 

or wirelessly through radio waves. Connected computers can share resources, like access to the 

Internet, printers, file servers, and others. A network is a multipurpose connection, which allows 

a single computer to do more. 

Types of Network Connections 

Computer networks can be broken down historically into topologies, which is a technique of 

connecting computers. The most common topology today is a collapsed ring. This is due to the 

success of a network protocol called the Ethernet. This protocol, or network language, supports 

the Internet, Local Area Networks, and Wide Area Networks. 

Characteristics of a Computer Network 

 Share resources from one computer to another. 

 Create files and store them in one computer, access those files from the other 

computer(s) connected over the network. 

 Connect a printer, scanner, or a fax machine to one computer within the network and 

let other computers of the network use the machines available over the network. 
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Following is the list of hardware's required to set up a computer network. 

 Network Cables 

 Distributors 

 Routers 

 Internal Network Cards 

 External Network Cards 

When looking at networking basics, understanding how a network operates is the first step to 

understanding routing, switching, and wireless. The network operates by connecting computers 

and peripherals using switches, routers, and access points. These devices are the essential 

networking basics that allow the various pieces of equipment connected to your network to 

communicate with one another, as well as with other networks. 

Routers, switches, and access points perform very different functions in a network. 

 Networking Basics: Switches 

Switches are used to connect multiple devices on the same network within a building or campus. 

For example, a switch can connect your computers, printers, and servers, creating a network of 

shared resources. The switch, one aspect of your networking basics, would serve as a controller, 

allowing the various devices to share information and talk to each other. Through information 

sharing and resource allocation, switches save you money and increase productivity. 

An unmanaged switch works out of the box and does not allow you to make changes. Home 

networking equipment typically includes unmanaged switches. 

A managed switch can be accessed and programmed. This capability provides greater network 

flexibility because the switch can be monitored and adjusted locally or remotely. With a 

managed switch, you have control over network traffic and network access. 

There are two basic types of switches to choose from as part of your networking basics: managed 

and unmanaged. 

 Networking Basics: Routers 

Routers, the second valuable component of your networking basics, are used to connect multiple 

networks together. For example, you would use a router to connect your networked computers to 

the Internet and thereby share an Internet connection among many users. The router will act as a 

dispatcher, choosing the best route for your information to travel so that you receive it quickly. 

Routers analyze the data being sent over a network, change how it is packaged, and send it to 

another network or to a different type of network. They connect your business to the outside 

world, protect your information from security threats, and can even decide which computers get 

priority over others. Depending on your business and your networking plans, you can choose 

from routers that include different capabilities. These can include networking basics such as: 

Firewall: Specialized software that examines incoming data and protects your business network 

against attacks. 

Virtual private network (VPN): A way to allow remote employees to safely access your network. 

https://www.cisco.com/c/en/us/solutions/small-business/switches.html
https://www.cisco.com/c/en/us/solutions/small-business/routers.html
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IP phone network: Combines your company's computer and telephone network, using voice and 

conferencing technology, to simplify and unify your communications. 

 Networking Basics:  Access Points 

An access point allows wireless devices to connect to the network. Having a wireless network 

makes it easy to bring new devices online and provides flexible support to mobile workers. 

Think of what an access point does for your network as being similar to what an amplifier does 

for your home stereo. An access point takes the bandwidth coming from a router and stretches it 

so that many devices can go on the network from farther distances away. But an access point 

does more than simply extend Wi-Fi. It can also give useful data about the devices on the 

network, provide proactive security, and serve many other practical purposes. 

Access points support different IEEE standards. Each standard is an amendment that was ratified 

over time, and the standards operate on varying frequencies, deliver different bandwidth, and 

support different numbers of channels. 

Networking Introduction 

A basic understanding of networking is important for anyone managing a server. Not only is it  

essential for getting your services online and running smoothly, it also gives you the insight to 

diagnose problems. 

 

Networking Glossary 

Before we begin discussing networking with any depth, we must define some common terms that 

you will see throughout this guide, and in other guides and documentation regarding networking. 

These terms will be expanded upon in the appropriate sections that follow: 

Connection: In networking, a connection refers to pieces of related information that are 

transferred through a network. This generally infers that a connection is built before the data 

transfer (by following the procedures laid out in a protocol) and then is deconstructed at the at 

the end of the data transfer. 

Packet: A packet is, generally speaking, the most basic unit that is transfered over a network. 

When communicating over a network, packets are the envelopes that carry your data (in pieces) 

from one end point to the other. 

Packets have a header portion that contains information about the packet including the source 

and destination, timestamps, network hops, etc. The main portion of a packet contains the actual 

data being transferred. It is sometimes called the body or the payload. 

Network Interface: A network interface can refer to any kind of software interface to 

networking hardware. For instance, if you have two network cards in your computer, you can 

control and configure each network interface associated with them individually. 

A network interface may be associated with a physical device, or it may be a representation of a 

virtual interface. The "loopback" device, which is a virtual interface to the local machine, is an 

example of this. 

https://www.cisco.com/c/en/us/solutions/small-business/wireless.html
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LAN: LAN stands for "local area network". It refers to a network or a portion of a network that 

is not publicly accessible to the greater internet. A home or office network is an example of a 

LAN. 

WAN: WAN stands for "wide area network". It means a network that is much more extensive 

than a LAN. While WAN is the relevant term to use to describe large, dispersed networks in 

general, it is usually meant to mean the internet, as a whole. 

If an interface is said to be connected to the WAN, it is generally assumed that it is reachable 

through the internet. 

Protocol: A protocol is a set of rules and standards that basically define a language that devices 

can use to communicate. There are a great number of protocols in use extensively in networking, 

and they are often implemented in different layers. 

Some low level protocols are TCP, UDP, IP, and ICMP. Some familiar examples of application 

layer protocols, built on these lower protocols, are HTTP (for accessing web content), SSH, 

TLS/SSL, and FTP. 

Port: A port is an address on a single machine that can be tied to a specific piece of software. It 

is not a physical interface or location, but it allows your server to be able to communicate using 

more than one application. 

Firewall: A firewall is a program that decides whether traffic coming into a server or going out 

should be allowed. A firewall usually works by creating rules for which type of traffic is 

acceptable on which ports. Generally, firewalls block ports that are not used by a specific 

application on a server. 

NAT: NAT stands for network address translation. It is a way to translate requests that are 

incoming into a routing server to the relevant devices or servers that it knows about in the LAN. 

This is usually implemented in physical LANs as a way to route requests through one IP address 

to the necessary backend servers. 

VPN: VPN stands for virtual private network. It is a means of connecting separate LANs 

through the internet, while maintaining privacy. This is used as a means of connecting remote 

systems as if they were on a local network, often for security reasons. 

There are many other terms that you may come across, and this list cannot afford to be 

exhaustive. We will explain other terms as we need them. At this point, you should understand 

some basic, high-level concepts that will enable us to better discuss the topics to come. 

Network Layers 

While networking is often discussed in terms of topology in a horizontal way, between hosts, its 

implementation is layered in a vertical fashion throughout a computer or network. 

What this means is that there are multiple technologies and protocols that are built on top of each 

other in order for communication to function more easily.  

Different Types of Networks 

Networks are known to be a medium of connection in this modern world. This has became the 

basis of every connection that we can do so that we can share some information to the people 
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that might want to learn something from us as well, or in order for them to get something that 

they might want such as software and any other files. Networks have improved over the past 

few years from wired into wireless, and there’s no doubt that this will further improve in the 

future – maybe they’re just using these as a basis for the next network trend. 

There are lots of networks that have been made possible by computers and technology, and 

they guarantee you various benefits that you and some might like to have on their computers 

and/or other devices. Here are the well-known types: 

Types of Networks 

 
 Personal Area Network – Often used at home, this network is more on connections between a 

computer and another gadget such as a telephone or a modem. 

 Local Area Network – A connection that’s used for groups of computers. This is common in 

small offices and internet cafes. This is where everyone can share files basically, and is also 

known to be a good way to connect between computers whenever they want to share an internet 

connection, or whenever they want to play games with each other. 

 Metropolitan Area Network – A more powerful version of the local area network where it can 

cover up the whole city in terms of connection. A huge server is usually used for this type of 

connection. 

 Wide Area Network – This is a common type of network nowadays that’s made possible by 

wireless technology. Usually, a credential or service from a certain company is needed to enter a 

connection in this type of network, but there are others that can be used for free. This is good for 

internet connection. The internet is a well-known version of this one. 

 Storage Area Network – A type of network that specializes in file sharing and other matters in 

storing various software within a group of computers. 

 Enterprise Private Network – This is a software network that’s often used in businesses so that 

they can have privacy over files and interactions between computers. 

 Virtual Private Network – This is a software that’s capable of setting up a network where 

everyone registered in the network using a credential will be able to access each other through 

other registered computers. 

Types of Switches 
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Understanding the various switches needed to turn the network will give you an understanding 

about the different kinds of things needed if you want to operate one. Here are as follows: 

 Unmanaged – This type of network switch is known to be used for small businesses. This is 

effectively used to manage the flow of data between computers or a single device. 

 Managed – This type of network switch is known to be accessed via software and has an 

interface that can make work easier. This is perfect for small businesses that need someone to 

monitor the system, and has various settings that can be adjusted by an expert so that the 

business owner can have their own preference within the network. 

 Smart Type – This is a web-based network that has the properties of unmanaged and managed 

switches. This is capable of changing settings in one network that can automatically affect the 

type of setting that’s in the system. 

 Enterprise – This is needed for large companies where there are various tiers of networks that 

can control the whole network and monitor it at the same time. This is the most powerful switch, 

yet the most expensive. 

Types of Cables 

 
This is the hardware part of the network so that it can effectively connect to the switches that 

you installed in your network. Here are the well-known cables used within a certain network: 
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 Twisted Pair Cables – (Ethernet Switch vs Router: Which One Is Better?) – This is the type 

of network cable that’s often used for Ethernet connections (or the well known Local Area 

Network connection). This is capable of providing 10/100/1000 Mbps for the network 

connection. 

 Fiber Optics – (Types of Fiber Optic Cable and Other Miscellaneous Facts) This is the type 

of cable that’s very powerful especially nowadays where this is used by most internet service 

providers for a fast way to a share internet connection to the subscribers. This is made using 

glass and light pulses. This is often used for WAN connections. 

 USB – There are some cables that are in USB form which is used for some devices such as 

mobile hotspots and other small devices for network connections. 

 Crossover – (What Crossover Cables You Might Need) These are cables that can be used for 

small multiple networks such as home connections. 

The Most Common Type of Home Network 

 

For those who want to set us a network at home, it’s a well-known fact that wireless local area 

connection is the widely used type of network inside the house. This is known to be the 

simplest and most convenient type of network that homes can use. Nowadays, there are many 

children and parents that prefer to use their smart phones especially if they’re not that good 

with computers which is why many people prefer WLAN because it will guarantee them a very 

convenient way to share things over the internet with no wires attached to the device 

Types of Computer Networks 

 

http://www.networking-basics.net/ethernet-switch-vs-router/
http://www.networking-basics.net/types-of-fiber-optic-cable/
http://www.networking-basics.net/crossover-cables/
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Here are some of the well known types of computer networks that you can use for your 

computers. 

 Local Area Network – This is often used as a computer network with a wired connection. This 

is perfect for internet cafes and homes. 

 Wide Area Network – This is the wireless version of a shared network. The internet is a well-

known wide area network connection. 

 Wireless Local Area Network –This is a computer network that’s dedicated for those who want 

to connect wirelessly, this is a well-known source of internet nowadays. Also called as Wi-Fi. 

 

Types of Network Protocols 

 

Protocols are used as a medium to access the network with the right credentials. This is needed 

to make the connection possible and is often used as an identifier for the devices that are 

connected within the network. You can control these protocols if you wish. Here are the well-

known protocols for network connections: 

Protocols 

Networking works by piggybacking a number of different protocols on top of each other. In this 

way, one piece of data can be transmitted using multiple protocols encapsulated within one 

another. 

We will talk about some of the more common protocols that you may come across and attempt to 

explain the difference, as well as give context as to what part of the process they are involved 

with. 

We will start with protocols implemented on the lower networking layers and work our way up 

to protocols with higher abstraction. 
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Media Access Control 

Media access control is a communications protocol that is used to distinguish specific devices. 

Each device is supposed to get a unique MAC address during the manufacturing process that 

differentiates it from every other device on the internet. 

Addressing hardware by the MAC address allows you to reference a device by a unique value 

even when the software on top may change the name for that specific device during operation. 

Media access control is one of the only protocols from the link layer that you are likely to 

interact with on a regular basis. 

 

IP 

The IP protocol is one of the fundamental protocols that allow the internet to work. IP addresses 

are unique on each network and they allow machines to address each other across a network. It is 

implemented on the internet layer in the IP/TCP model. 

Networks can be linked together, but traffic must be routed when crossing network boundaries. 

This protocol assumes an unreliable network and multiple paths to the same destination that it 

can dynamically change between. 

There are a number of different implementations of the protocol. The most common 

implementation today is IPv4, although IPv6 is growing in popularity as an alternative due to the 

scarcity of IPv4 addresses available and improvements in the protocols capabilities. 

ICMP 

ICMP stands for internet control message protocol. It is used to send messages between devices 

to indicate the availability or error conditions. These packets are used in a variety of network 

diagnostic tools, such as ping and trace route. 

Usually ICMP packets are transmitted when a packet of a different kind meets some kind of a 

problem. Basically, they are used as a feedback mechanism for network communications. 

TCP 

TCP stands for transmission control protocol. It is implemented in the transport layer of the 

IP/TCP model and is used to establish reliable connections. 

TCP is one of the protocols that encapsulates data into packets. It then transfers these to the 

remote end of the connection using the methods available on the lower layers. On the other end, 

it can check for errors, request certain pieces to be resent, and reassemble the information into 

one logical piece to send to the application layer. 

The protocol builds up a connection prior to data transfer using a system called a three-way 

handshake. This is a way for the two ends of the communication to acknowledge the request and 

agree upon a method of ensuring data reliability. 

After the data has been sent, the connection is torn down using a similar four-way handshake. 

TCP is the protocol of choice for many of the most popular uses for the internet, including 

WWW, FTP, SSH, and email. It is safe to say that the internet we know today would not be here 

without TCP. 
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UDP 

UDP stands for user datagram protocol. It is a popular companion protocol to TCP and is also 

implemented in the transport layer. 

The fundamental difference between UDP and TCP is that UDP offers unreliable data transfer. It 

does not verify that data has been received on the other end of the connection. This might sound 

like a bad thing, and for many purposes, it is. However, it is also extremely important for some 

functions. 

Because it is not required to wait for confirmation that the data was received and forced to resend 

data, UDP is much faster than TCP. It does not establish a connection with the remote host, it 

simply fires off the data to that host and doesn't care if it is accepted or not. 

Because it is a simple transaction, it is useful for simple communications like querying for 

network resources. It also doesn't maintain a state, which makes it great for transmitting data 

from one machine to many real-time clients. This makes it ideal for VOIP, games, and other 

applications that cannot afford delays. 

HTTP 

HTTP stands for hypertext transfer protocol. It is a protocol defined in the application layer that 

forms the basis for communication on the web. 

HTTP defines a number of functions that tell the remote system what you are requesting. For 

instance, GET, POST, and DELETE all interact with the requested data in a different way. 

FTP 

FTP stands for file transfer protocol. It is also in the application layer and provides a way of 

transferring complete files from one host to another. 

It is inherently insecure, so it is not recommended for any externally facing network unless it is 

implemented as a public, download-only resource. 

DNS 

DNS stands for domain name system. It is an application layer protocol used to provide a 

human-friendly naming mechanism for internet resources. It is what ties a domain name to an IP 

address and allows you to access sites by name in your browser. 

SSH 

SSH stands for secure shell. It is an encrypted protocol implemented in the application layer that 

can be used to communicate with a remote server in a secure way. Many additional technologies 

are built around this protocol because of its end-to-end encryption and ubiquity. 

There are many other protocols that we haven't covered that are equally important. However, this 

should give you a good overview of some of the fundamental technologies that make the internet 

and networking possible. 

Bluetooth – This is often used for wireless purposes. This is often used in phones and is now 

used for gadgets like headsets and laptops for transmission of various features. 

Routing – This protocol is used for computers and other devices that are connected within a 

router. This is common for internet connection nowadays. 
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Types of Network Topologies 

 
A topology for the network is known to be a layout for the connected devices. This is important 

because this is used to provide a proper flow of data within the said network. Here are the 

various topologies: 

 Bus – This is the type of structure that uses a single medium to connect the computer. 

 Ring – Each computer is connected to another neighboring computer for data transfer. One 

failed network can cause all networks to turn off. 

 Star – This is a structure that’s common in homes. It uses a certain hub or a router to make the 

network possible. 

 Tree – This is a complicated structure that connects the star into multiple buses. This is common 

for internet cafes and offices. 

 Mesh – this is a connection that leads to various data transmissions which are perfect for routing 

huge networks. 

Network Topologies: 

Network Topology is the schematic description of a network arrangement, connecting 

various nodes (sender and receiver) through lines of connection. 

BUS Topology 

Bus topology is a network type in which every computer and network device is connected to 

single cable. When it has exactly two endpoints, then it is called Linear Bus topology. 

 
Features of Bus Topology 

 It transmits data only in one direction. 

 Every device is connected to a single cable 

Advantages of Bus Topology 

 It is cost effective. 

http://www.networking-basics.net/network-topology/
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 Cable required is least compared to other network topology. 

 Used in small networks. 

 It is easy to understand. 

 Easy to expand joining two cables together. 

Disadvantages of Bus Topology 

 Cables fails then whole network fails. 

 If network traffic is heavy or nodes are more the performance of the network decreases.  

 Cable has a limited length.  

 It is slower than the ring topology. 

 

RING Topology 

It is called ring topology because it forms a ring as each computer is connected to another 

computer, with the last one connected to the first. Exactly two neighbours for each device. 

 
Features of Ring Topology 

 A number of repeaters are used for Ring topology with large number of nodes, because if 

someone wants to send some data to the last node in the ring topology with 100 nodes, 

then the data will have to pass through 99 nodes to reach the 100th node. Hence to 

prevent data loss repeaters are used in the network. 

 The transmission is unidirectional, but it can be made bidirectional by having 2 

connections between each Network Node, it is called Dual Ring Topology. 

 In Dual Ring Topology, two ring networks are formed, and data flow is in opposite 

direction in them. Also, if one ring fails, the second ring can act as a backup, to keep the 

network up. 

 Data is transferred in a sequential manner that is bit by bit. Data transmitted, has to pass 

through each node of the network, till the destination node. 

Advantages of Ring Topology 

 Transmitting network is not affected by high traffic or by adding more nodes, as only the 

nodes having tokens can transmit data. 
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 Cheap to install and expand 

Disadvantages of Ring Topology 

 Troubleshooting is difficult in ring topology. 

 Adding or deleting the computers disturbs the network activity. 

 Failure of one computer disturbs the whole network. 

 

 

STAR Topology 

In this type of topology all the computers are connected to a single hub through a cable. This hub 

is the central node and all others nodes are connected to the central node.  

 
Features of Star Topology 

 Every node has its own dedicated connection to the hub. 

 Hub acts as a repeater for data flow. 

 Can be used with twisted pair, Optical Fibre or coaxial cable. 

Advantages of Star Topology 

 Fast performance with few nodes and low network traffic. 

 Hub can be upgraded easily. 

 Easy to troubleshoot. 

 Easy to setup and modify. 

 Only that node is affected which has failed, rest of the nodes can work smoothly. 

Disadvantages of Star Topology 

 Cost of installation is high. 

 Expensive to use. 

 If the hub fails then the whole network is stopped because all the nodes depend on the 

hub. 

 Performance is based on the hub that is it depends on its capacity 

MESH Topology 

It is a point-to-point connection to other nodes or devices. All the network nodes are connected 

to each other. Mesh has n(n-1)/2 physical channels to link n devices. 

There are two techniques to transmit data over the Mesh topology, they are : 

 Routing 
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 Flooding 

 Routing 

In routing, the nodes have a routing logic, as per the network requirements. Like routing logic to 

direct the data to reach the destination using the shortest distance. Or, routing logic which has 

information about the broken links, and it avoids those nodes etc. We can even have routing 

logic, to re-configure the failed nodes. 

 

Flooding: 

In flooding, the same data is transmitted to all the network nodes, hence no routing logic is 

required. The network is robust, and the its very unlikely to lose the data. But it leads to 

unwanted load over the network. 

 
Types of Mesh Topology 

 Partial Mesh Topology: In this topology some of the systems are connected in the same 

fashion as mesh topology but some devices are only connected to two or three devices. 

 Full Mesh Topology: Each and every nodes or devices are connected to each other. 

 Features of Mesh Topology 

 Fully connected. 

 Robust. 

 Not flexible. 

 Advantages of Mesh Topology 

 Each connection can carry its own data load. 

 It is robust. 

 Fault is diagnosed easily. 

 Provides security and privacy. 

Disadvantages of Mesh Topology 

 Installation and configuration is difficult. 

 Cabling cost is more. 
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 Bulk wiring is required. 

TREE Topology 

It has a root node and all other nodes are connected to it forming a hierarchy. It is also called 

hierarchical topology. It should at least have three levels to the hierarchy. 

 
Features of Tree Topology 

 Ideal if workstations are located in groups.  

 Used in Wide Area Network. 

Advantages of Tree Topology 

 Extension of bus and star topologies. 

 Expansion of nodes is possible and easy. 

 Easily managed and maintained. 

 Error detection is easily done. 

Disadvantages of Tree Topology 

 Heavily cabled. 

 Costly. 

 If more nodes are added maintenance is difficult. 

 Central hub fails, network fails. 

HYBRID Topology 

It is two different types of topologies which is a mixture of two or more topologies. For example 

if in an office in one department ring topology is used and in another star topology is used, 

connecting these topologies will result in Hybrid Topology (ring topology and star topology).  

Types of Wireless Networks 
This is a more modern form of network nowadays since this is more convenient. This is 

currently being studied to make all network wireless for the future. This type of network is 

similar to the standard type of connections for networks. Here are the various types of wireless 

networks: 

 Local Area Network 

 Metropolitan Area Network 

 Personal Area Network 
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 Wide Area Networks 

 

Types of Network Architecture 

 
Network architecture is known to be a way of building various kinds of networks with the use 

of technology and logic combined. This is known to be the basis for all networks, and this 

research has made your internet accessible nowadays. Here are the common types of network 

architecture: 

 Physical Layer – This is more about the wires and its electrical equivalent. 

 Data Linking Layer – this is more about the structure of the data transmission. 

 Network Layer – A layer that’s focused about the various network connections involved. 

 Transport Layer – It handles the transfer of data for the end users. 

 Session Layer – It indicates the session needed to start the connection. 

 Presentation Layer – This makes the entities of the application layer active for usage. 

 Application Layer – This is the layer that’s closest to the end user which mostly involves 

the software for the network connection type. 

 

Types of Networks 

 

LAN (Local Area Network) 

 A Local Area Network is a privately owned computer network covering a small Networks 

geographical area, like a home, office, or groups of buildings e.g. a school Network. A LAN is 

used to connect the computers and other network devices so that the devices can communicate 

with each other to share the resources. The resources to be shared can be a hardware device 

like printer, software like an application program or data. The size of LAN is usually small. The 

various devices in LAN are connected to central devices called Hub or Switch using a cable. 

Now-a-days LANs are being installed using wireless technologies. Such a system makes use of 

access point or APs to transmit and receive data. One of the computers in a network can become 

a server serving all the remaining computers called Clients. 

For example, a library will have a wired or wireless LAN Network for users to interconnect 

local networking devices e.g., printers and servers to connect to the internet. 

http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
http://ecomputernotes.com/fundamental/input-output-and-memory/what-is-a-printer-and-what-are-the-different-types-of-printers


47 
 

LAN offers high speed communication of data rates of 4 to 16 megabits per second 

(Mbps). IEEE has projects investigating the standardization of 100 Gbit/s, and possibly 40 

Gbit/s. LANs Network may have connections with other LANs Network via leased lines, leased 

services. 

 Types of LAN  

 There are basically two types of Local Area Networks namely: ARCNET and Ethernet. 

 ARCNET (Attached Resource Computer Network) 

ARCNET is one of the oldest, simplest, and least expensive types of Local-

Area Network protocol, similar in purpose to Ethernet or Token Ring. ARCNET was the first 

widely available networking system for microcomputers and became popular in the 1980s for 

office automation tasks. ARC net was introduced by Data point Corporation in 1977.   

A special advantage of ARCNET is that it permits various types of transmission media - twisted-

pair wire, coaxial cable, and fiber optic cable - to be mixed on the same network. The 

specification is ANSI 878.1. It can have up to 255 nodes per network. 

MAN (Metropolitan Area Networks) 

MAN stands for Metropolitan Area Networks is one of a number of types of networks. A MAN 

is a relatively new class of network. MAN is larger than a local area network and as its name 

implies, covers the area of a single city. MANs rarely extend beyond 100 KM and frequently 

comprise a combination of different hardware and transmission media. It can be single network 

such as a cable TV network, or it is a means of connecting a number of LANs into a larger 

network so that resources can be shared LAN to LAN as well as device to device. 

   

 

A MAN can be created as a single network such as Cable TV Network, covering the entire city 

or a group of several Local Area Networks (LANs). It this way resource can be shared from 

http://ecomputernotes.com/computernetworkingnotes/computer-network/protocol
http://ecomputernotes.com/images/MAN.jpg
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LAN to LAN and from computer to computer also. MANs are usually owned by large 

organizations to interconnect its various branches across a city. 

MAN is based on IEEE 802.6 standard known as DQDB (Distributed Queue Dual Bus). DQDB 

uses two unidirectional cables (buses) and all the computers are connected to these two buses. 

Each bus has a specialized device that initiates the transmission activity. This device is called 

head end. Data that is to be sent to the computer on the right hand side of the sender is 

transmitted on upper bus. Data that is to be sent to the left hand side of the sender is transmitted 

on lower bus. 

 

The two most important components of MANs are security and standardization. Security is 

important because information is being shared between dissimilar systems. Standardization is 

necessary to ensure reliable data communication. 

A MAN usually interconnects a number of local area networks using a high-capacity backbone 

technology, such as fiber-optical links, and provides up-link services to wide area networks and 

the Internet. 

The Metropolitan Area Networks (MAN) protocols are mostly at the data link level (layer 2 in 

the OSI model), which are defined by IEEE, ITU-T, etc. 

WAN (Wide Area Networks) 

A wide area network (WAN) is a telecommunication network. A wide area network is simply a 

LAN of LANs or Network of Networks. WANs connect LANs that may be on opposite sides of 

a building, across the country or around the world. WANS are characterized by the slowest data 

communication rates and the largest distances. WANs can be of two types: an enterprise WAN 

and Global WAN. 

http://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
http://ecomputernotes.com/images/Architecture-of-DQDB.jpg
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Computers connected to a Wide Area Networks are often connected through public networks, 

such as the telephone system. They can also be connected through leased lines or satellites. The 

largest WAN in existence is the Internet. Some segments of the Internet, like VPN based 

extranets, are also WANs in themselves. Finally, many WANs are corporate or research 

networks that utilize leased lines. 

Numerous WANs have been constructed, including public packet networks, large corporate 

networks, military networks, banking networks, stock brokerage networks, and airline 

reservation networks. 

Organizations supporting WANs using the Internet Protocol are known as Network Service 

Providers (NSPs). These form the core of the Internet. 

By connecting the NSP WANs together using links at Internet Packet Interchanges (sometimes 

called "peering points") a global communication infrastructure is formed. 

WANs (wide area networks) generally utilize different and much more expensive networking 

equipment than do LANs (Local Area Networks). Key technologies often found in WANs (wide 

area networks) include SONET, Frame Relay, and ATM. 

Clarify Enterprise WANs. 

An enterprise WAN (wide area networks) connects an entire organization including all LANs 

(Local Area Networks) at various sites. This term is used for large, widespread organizations 

such as corporations, universities and governments. 

Clarify Global WANs. 

Global WANs (wide area networks) also span the world but they do not have to connect 

LANS (Local Area Networks) within a single organization. The Internet is an example of a 

global WAN. It connects diverse locations, organizations and institutions throughout the world. 

Global WANS (wide area networks) can be public or private. Private WANs (wide area 

networks) are called Intranet which belongs to an organization. Public WANs (wide area 

http://ecomputernotes.com/images/WAN.jpg
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networks) are open to everybody so that anybody can connect and use the resources and services 

available. 

WLANs - Wireless Local Area Networks 

WLANs (Wireless Local Area Networks or sometimes referred to as LAWN, for local area 

wireless network) provide wireless network communication over short distances using radio or 

infrared signals instead of traditional network cabling. WLANs (Wireless Local Area Networks) 

is one in which a mobile user can connect to a local area network (LAN) through a wireless 

(radio) connection 

Norman Abramson, a professor at the University of Hawaii, developed the world’s first wireless 

computer communication network, 

A WLAN typically extends an existing wired local area network. WLANs (Wireless Local Area 

Networks) are built by attaching a device called the access point (AP) to the edge of the wired 

network. Clients communicate with the AP using a wireless network adapter similar in function 

to a traditional Ethernet adapter.  

Network security remains an important issue for WLANs (Wireless Local Area Networks). 

Random wireless clients must usually be prohibited from joining the WLAN. Technologies like 

WEP raise the level of security on wireless networks to rival that of traditional wired networks.  

The IEEE 802.11 group of standards specify the technologies for wireless LANs. 802.11 

standards use the Ethernet 

WLAN (Wireless Local Area Networks) hardware was initially so expensive that it was only 

used as an alternative to cabled LAN in places where cabling was difficult or impossible. 

All components that can connect into a wireless medium in a network are referred to as stations. 

All stations are equipped with wireless network interface controllers (WNICs). Wireless stations 

fall into one of two categories: access points, and clients. Access points (APs), normally routers, 

are base stations for the wireless network. 

They transmit and receive radio frequencies for wireless enabled devices to communicate with. 

Wireless clients can be mobile devices such as laptops, personal digital assistants, IP phones and 

other smart phones, or fixed devices such as desktops and workstations that are equipped with a 

wireless network interface.  

WLAN (Wireless Local Area Networks) types 

Private home or small business WLAN 

Commonly, a home or business WLAN employs one or two access points to broadcast a signal 

around a 100- to 200-foot radius. You can find equipment for installing a home WLAN in many 

retail stores. 

With few exceptions, hardware in this category subscribes to the 802.11a, b, or g standards (also 

known as Wi-Fi); some home and office WLANs now adhere to the new 802.11n standard. Also, 
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because of security concerns, many home and office WLANs adhere to the Wi-Fi Protected 

Access 2 (WPA2) standard. 

Enterprise class WLAN 

 An enterprise class WLAN employs a large number of individual access points to broadcast the 

signal to a wide area. The access points have more features than home or small office WLAN 

equipment, such as better security, authentication, remote management, and tools to help 

integrate with existing networks. These access points have a larger coverage area than home or 

small office equipment, and are designed to work together to cover a much larger area. This 

equipment can adhere to the 802.11a, b, g, or n standard, or to security-refining standards, such 

as 802.1x and WPA2. 

Examples: 

For WLANs that connect to the Internet, Wireless Application Protocol (WAP) technology 

allows Web content to be more easily downloaded to a WLAN and rendered on wireless clients 

like cell phones and PDAs. 

Storage Area Network (SAN): 

A storage area network (SAN) is a type of local area network (LAN) is a high-speed special-

purpose network. A SAN typically supports data storage, retrieval and replication on business 

networks using high-end servers, multiple disk arrays and Fibre Channel interconnection 

technology. 

Storage Area Networks (SANs) technology is similar but distinct from network attached 

storage (NAS) technology. While SANs traditionally employ low-level network protocols for 

transferring disk blocks, a NAS device typically works over TCP/IP and can be integrated fairly 

easily into home computer networks. 

The term SAN can sometimes refer to system area networks instead of a storage area network. 

System area networks are clusters of high performance computers used for distributed processing 

applications requiring fast local network performance. Storage area networks, on the other, are 

designed specifically for data management. 

SANs support disk mirroring, backup and restore, archival and retrieval of archived data, data 

migration from one storage device to another and the sharing of data among different servers in a 

network. SANs can incorporate sub networks with network attached storage (NAS) systems. 

Storage Area Networks Make Your Life Easier 

Simplification of Storage Administration is now possible because of Storage Area Networks 

cause cables and storage devices doesn’t need to be moved physically. Moving data from one 

server into another is now a breeze. Thanks to Storage Area Networks. Life is much easier. 

Before, storage area networks process can take as little as half an hour. But this was before and 

now we can accelerate it. 

http://ecomputernotes.com/fundamental/input-output-and-memory/explain-secondary-storage-devices
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The boo-table features of Storage Area Networks can also be effective and enable during 

recovery of data because of certain disaster such as server failure or human error. Storage area 

networks are great tools in recovering important data and backups. Distant location doesn’t affect 

the storage area networks as long as the secondary storage array is working. 

This enables storage replication either implemented by disk array controllers, by server software, 

or by specialized SAN devices. Since IP WAN’s are often the least costly method of long-

distance transport, the Fiber Channel over IP (FCIP) and ISCSI protocols have been developed to 

allow SAN extension over IP networks. 

In the old model like in physical SCSI layer, it supported a few meters of distance and no 

guarantee of business continuity when disaster strike.  In storage area networks, the disk arrays 

has accelerated and consolidated in the features like I/O caching, volume cloning and snap 

shotting making business continuance possible or BCV’s (Business Continuance Volumes). 

Campus Area Network (CAN)  

A campus area networks (CANs) is a computer network interconnecting a few local area 

networks (LANs) within a university campus or corporate campus Network. Campus area 

network may link a variety of campus buildings. A campus area network is larger than a local 

area network but smaller than a metropolitan area network (MAN) or wide area network (WAN). 

CAN can also stand for corporate area network.  

Personal Area Network (PAN) 

A personal area network is a computer network organized around an individual person. Personal 

area networks typically involve a mobile computer, Personal area networks can be constructed 

with cables or wirelessly. Personal area networks generally cover a Network range of less than 

10 meters (about 30 feet). 

PAN (Personal Area Network) first was developed by Thomas Zimmerman and other 

researchers at M.I.T.'s Media Lab and later supported by IBM's Alma den research lab. 

Wireless Personal Area Network (WPAN) which is virtually a synonym since almost any 

personal area network would need to function wirelessly. Conceptually, the difference between a 

PAN (Personal Area Network) and a wireless LAN (Local Area Network) is that the former 

tends to be centered around one person Network while the latter is a local area network (LAN) 

that is connected without wires Network and serving multiple users. 

Wireless Networks 

• The fastest growing segment of the computer industry is the mobile computers such 

as notebook computers and personal digital assistant (PDAs). 

• The wireless networks are becoming increasingly important because the wired connection is 

not possible in cars or aero planes. 

• Wireless networks can have many applications. A very common example is the portable office 
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• People traveling on road often want to make use of their portable electronic equipment for 

telephone calls, e-mails, faxes, read remote files etc. 

• Wireless networks can exist on trucks, buses, taxies, aero planes etc. They are used where the 

telephone systems are destroyed in the event of disasters such as. fires, floods and earthquakes 

etc. 

• The wireless networks are important for military. 

• Wireless networks and mobile computing are related but they are not identical because portable 

computers are sometimes wired and some wireless computers are not portable. 

• But some applications are truly mobile wireless applications such as a portable office, 

inventories being handled by PDAs, etc. 

• Wireless LAN is another example of wireless network. Direct digital cellular service CDPD 

(Cellular Digital Packet Data) is now becoming available: 

• It is possible to have combinations of wired and wireless networking. 

 

 

Basic Cloud Computing Service Models 

Companies are experiencing an unprecedented burden on their IT infrastructure as they struggle 

to meet growing customer expectations for fast, reliable, and secure services. As they try to 

increase the processing power and storage capabilities of their IT systems, often these companies 

find that the development and maintenance of a robust, scalable, and secure IT infrastructure is 

prohibitively expensive. 

 

Luckily, there is another option; instead of acquiring extra hardware, your company can embrace 

cloud computing. Cloud computing is a rapidly-growing industry which allows companies to 

move beyond on-premise IT infrastructure and, instead, rely on internet-based services. Cloud-

based providers often offer services such as software, storage, and processing at affordable 

prices. I 

 

Cloud computing is offered in three different service models which each satisfy a unique set of 

business requirements. These three models are known as Software as a Service (SaaS), Platform 

as a Service (PaaS), and Infrastructure as a Service (IaaS). 

 

SaaS 

Software as a Service offers applications that are accessed over the web and are not managed by 

your company, but by the software provider. This relieves your organization from the constant 

pressure of software maintenance, infrastructure management, network security, data 

availability, and all the other operational issues involved with keeping applications up and 

running. SaaS billing is typically based on factors such as number of users, usage time, amount 

of data stored, and number of transactions processed. This service model has the largest market 

share in cloud computing; according to Gartner. 

 

PaaS 

Platform as a Service is halfway between Infrastructure as a Service (IaaS) and Software as a 

Service (SaaS). It offers access to a cloud-based environment in which users can build and 
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deliver applications without the need of installing and working with IDEs (Integrated 

Development Environments, which are often very expensive. Additionally, users can often 

customize the features they want included with their subscription.  

 

IaaS 

Infrastructure as a service offers a standardized way of acquiring computing capabilities on 

demand and over the web. Such resources include storage facilities, networks, processing power, 

and virtual private servers. These are charged under a “pay as you go” model where you are 

billed by factors such as how much storage you use or the amount of processing power you 

consume over a certain timespan. In this service model, customers do not need to manage 

infrastructure, it is up to the provider to guarantee the contracted amount of resources and 

availability. 
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Unit-V: Smart Tools & Apps 

Smartcard: 

A smart card, typically a type of chip card, is a plastic card that contains an embedded computer 

chip–either a memory or microprocessor type–that stores and transacts data. This data is usually 

associated with either value, information, or both and is stored and processed within the card's 

chip. The card data is transacted via a reader that is part of a computing system. Systems that are 

enhanced with smart cards are in use today throughout several key applications, including 

healthcare, banking, entertainment, and transportation. All applications can benefit from the 

added features and security that smart cards provide. 

Smart cards improve the convenience and security of any transaction. They provide tamper-proof 

storage of user and account identity. Smart card systems have proven to be more reliable than 

other machine-readable cards, like magnetic stripe and barcode, with many studies showing card 

read life and reader life improvements demonstrating much lower cost of system maintenance. 

Smart cards also provide vital components of system security for the exchange of data 

throughout virtually any type of network. They protect against a full range of security threats, 

from careless storage of user passwords to sophisticated system hacks. The costs to manage 

password resets for an organization or enterprise are very high, thus making smart cards a cost-

effective solution in these environments. Multifunction cards can also be used to manage 

network system access and store value and other data. Worldwide, people are now using smart 

cards for a wide variety of daily tasks, which include: 

SIM Cards and Telecommunication 

The most prominent application of smart card technology is in Subscriber Identity Modules 

(SIM), required for all phone systems under the Global System for Mobile Communication 

(GSM) standard. Each phone utilizes the unique identifier, stored in the SIM, to manage the 

rights and privileges of each subscriber on various networks. This use case represents over 

half of all smart cards consumed each year. The Universal Subscriber Identification 

Modules (USIM) is also being used to bridge the identity gap as phones transition between 

GSM, UTMS, and 3G network operators. 

Loyalty and Stored Value 

Another use of smart cards is stored value, particularly loyalty programs that track and 

provide incentives to repeat customers. Stored value is more convenient and safer than cash. 

For issuers, float is realized on unspent balances and residuals on balances that are never 

used. 

For multi-chain retailers that administer loyalty programs across many different businesses 

and POS systems, smart cards can centrally locate and track all data. The applications are 

numerous, such as transportation, parking, laundry, gaming, retail, and entertainment. 

Securing Digital Content and Physical Assets 

In addition to information security, smart cards can ensure greater security of services and 

equipment by restricting access to only authorized user(s). 

http://www.smartcardbasics.com/smart-card-types.html#memory-card
http://www.smartcardbasics.com/smart-card-types.html#microprocessor-card
http://www.smartcardbasics.com/smart-card-types.html#microprocessor-card
http://www.cardlogix.com/products/cards/smart/scfamilies/delos.asp
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Information and entertainment is being delivered via satellite or cable to the home DVR 

player or cable box or cable-enabled PC. Home delivery of service is encrypted and 

decrypted via the smart card per subscriber access. Digital video broadcast systems have 

already adopted smart cards as electronic keys for protection. 

Smart cards can also act as keys to machine settings for sensitive laboratory equipment and 

dispensers for drugs, tools, library cards, health club equipment etc. In some environments, 

smart card enabled- SD and microSD cards are protecting digital content as it is being 

delivered to the mobile hand-sets/phones. 

E-Commerce 

Smart cards make it easy for consumers to securely store information and cash for 

purchasing. The advantages they offer consumers are: 

 The card can carry personal account, credit and buying preference information that 

can be accessed with a mouse click instead of filling out forms. 

 Cards can manage and control expenditures with automatic limits and reporting. 

 Internet loyalty programs can be deployed across multiple vendors with disparate 

POS systems and the card acts as a secure central depository for points or rewards. 

 Micro Payments - paying nominal costs without transaction fees associated with 

credit cards, or for amounts too small for cash, like reprint charges. 

Bank Issued Smart Cards 

Around the globe, bank controlled co-ops (Visa, MasterCard, Discover, and American 

Express) have rolled out millions of smart cards under the EMV (Europay, MasterCard, 

VISA) standard. Often referred to as chip and PIN cards; these are the de facto types of 

cards for bank issuance in most countries except the U.S. As Canada has just recently 

started its regulatory shift to EMV cards, the U.S. will be the sole island in North America 

that has not yet made the adoption, which is being driven by the increased types of fraud 

with both credit and debit cards. Smart cards have been proven to secure transactions with 

regularity, so much so that the EMV standard has become the norm. 

As banks enter competition in newly opened markets such as investment brokerages, they 

are securing transactions via smart cards at an increased rate. This means: 

 Smart cards increase trust through improved security. Two-Factor Authentication 

insures protection of data and value across the internet. Threats such as the "Man in 

the middle" and "Trojan Horses" that replay a user name and password are eliminated 

 This is improving customer service. Customers can use secure smart cards for fast, 

24-hour electronic funds transfers over the internet 

 Costs are reduced: transactions that normally would require a bank employee's time 

and paperwork can be managed electronically by the customer with a smart card 

Healthcare Informatics: 

The explosion of health care data introduces new challenges in maintaining the efficiency 

of patient care and privacy safeguards. Smart cards address both of these challenges with 

secure, mobile storage and distribution of patient information, from emergency data to 

benefits status. Many socialized countries have already adopted smart cards as credentials 

http://www.smartcardbasics.com/smart-card-security_2.html#cryptography
http://www.smartcardbasics.com/smart-card-security_2.html#cryptography
http://www.emvco.com/
http://www.smartcardbasics.com/smart-card-standards.html#emv
http://www.cardlogix.com/products/cards/smart/scfamilies/healthcare.asp
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for their health networks and as a means of carrying an immediately retrievable Electronic 

Health Record (EHR). Smart card benefits in healthcare include: 

 Rapid, accurate identification of patients; improved treatment 

 Reducing fraud through authentication of provider/patient visits and insurance 

eligibility 

 A convenient way to carry data between systems or to sites without systems 

 Reducing record maintenance costs 

Embedded Medical Device Control: 

For years, embedded controllers have been in many types of machines, governing the 

quality and precision of their function. In Healthcare, embedded smart cards ensure the 

best and safest delivery of care in devices such as dialysis machines, blood analyzers and 

laser eye surgery equipment. 

Enterprise and Network Security: 

Microsoft Windows, Sun Microsystems (a subsidiary of Oracle Corporation) and all new 

versions of Linux have built-in software hooks to deploy smart cards as a replacement for 

user name and passwords. Microsoft has built a complete credential platform around the S 

card DLL and Crypto Service Provider (CSP). With enterprises realizing that Public Key 

Infrastructure (PKI)-enhanced security is what is needed for widely deployed employees, a 

smart card badge is the new standard. Business-to-business Intranets and Virtual Private 

Networks (VPNs) are enhanced by the use of smart cards. Users can be authenticated and 

authorized to have access to specific information based on preset privileges. Additional 

applications range from secure email to electronic commerce. 

Physical Access: 

Businesses and universities of all types need simple identity cards for all employees and 

students. Most of these individuals are also granted access to certain data, equipment, and 

departments according to their status. Multifunction, microprocessor-based smart 

cards incorporate identity with access privileges and can also store value for use in various 

locations, such as cafeterias and stores. Many hotels have also adopted ISO 7816 type card 

readers to secure staff-only rooms and facilities. 

All U.S. government and many corporations have now incorporated a contactless reader as 

an access point to their facilities. Some companies have incorporated a biometric 

component to this credential as well. The older systems deploy a simple proximity card 

system as the gate keeper. But as the security requirements have become stronger and the 

cost of ISO 14443 standard systems have become lower, the world is rapidly adopting this 

new standard. This market shift is partially driven by the US government’s adoption of the 

mandated Personal Identity Verification (PIV) standard. There is a rich ecosystem of 

suppliers and integrators for this standard. 

Advantages  

 Faster and smarter  

 Portability  

 Flexibility (no need to carry separate ATM,  Debit, credit card or pan card etc)  

 Highly security (deactivates on illegal use        

http://www.cardlogix.com/docs/whitepapers/CardLogix_WP_Winplex.pdf
http://www.cardlogix.com/docs/whitepapers/CardLogix_WP_Winplex.pdf
http://www.smartcardbasics.com/smart-card-types.html#microprocessor-card
http://www.smartcardbasics.com/smart-card-types.html#microprocessor-card
http://www.smartcardbasics.com/smart-card-standards.html#iso14443
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Disadvantages 

 Easily Lost  

 Possible Risk of Identify Theft  

 High probability for damage of card.  

 EXPENSIVE 

 

Online Payment Apps 

 PAYTM: 

Paytm, owned by One97 Communications, is a digital payments platform that allows you to 

transfer cash into the integrated wallet via online banking, debit cards, and credit cards, or even 

by depositing cash via select banks and partners. Using the money in the Paytm wallet, you can 

pay for a number of goods without using cash. 

Among the transactions you can make on Paytm are recharges for mobile phones, metro cards, 

DTH cable, data cards, etc, as well as postpaid payments for mobile phones, landline/ broadband, 

electricity, water and gas bills, etc. You can also book tickets for buses, trains, flights, movies, 

hotel rooms, etc. and pay for Uber cab rides using the platform. Additionally, you can buy goods 

on the company’s e-commerce platform using the wallet, and even make offline payments at 

over 8 lakh merchants, Paytm claims. 

What is Paytm Wallet? 

Paytm Wallet, as mentioned above, is the digital payment instrument where you can transfer 

money from your bank account or credit card to use for transactions on the platform. You need to 

set up an account using your mobile phone number and email ID to setup a Paytm account and 

transfer cash to the wallet. You can add up to Rs. 10,000 in a month in the Wallet; if you want to 

increase the monthly limit, then you can get the KYC (Know Your Customer) processor done. 

With this, you can have up to Rs. 1 lakh in the Paytm Wallet at any point of time. 

Paytm and Paytm Wallet 

In order to use the Paytm Wallet and transact cash-free, follow the steps below: 

1. Set up a Paytm account using your mobile number and email ID 

2. Add some money to your Paytm Wallet using netbanking, debit card, or credit card 

3. To transfer money to someone else, select the 'Pay or Send' option 

4. You can make payments to others or to bank accounts on Paytm by scanning a QR code 

5. Alternatively, you can send money to another Paytm user via their phone number 

Paytm for offline payments 

You can make cash-less payments using Paytm Wallet even without internet connectivity. If a 

retailer accepts Paytm as a mode of payment, you can either use QR codes or bar codes, along 

with a One-Time Password (OTP) to pay them. To do this, you need to open the app, select the 

https://gadgets.ndtv.com/tags/digital-payments
https://gadgets.ndtv.com/apps/news/rs-500-1000-ban-paytm-unveils-nearby-feature-to-help-discover-paytm-ready-merchants-1624583
https://gadgets.ndtv.com/tags/paytm-wallet
https://gadgets.ndtv.com/apps/features/paytm-bank-transfer-charges-how-to-account-wallet-1629798
https://gadgets.ndtv.com/apps/news/paytm-to-enable-cashless-payments-at-small-merchants-using-qr-codes-752467
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‘Pay or Send’ option, and choose between QR code and bar codes (provided in two separate 

tabs). Just scan the code and enter the OTP to authorize the payment offline. This feature can be 

especially useful right now, when the whole country is facing a cash crunch and internet 

connectivity is still not good enough to facilitate online transactions. 

 Other Payment apps: 

 Google Pay 

 Amazon Pay 

 JIO Money 

 Freecharge 

 Yono SBI 

 Airtel Money 

 Payzapp 

 MobiKwik 

 Oxigen 

 Ola money 

 PhonePe 

 MSwipe 

 Axis Bank Lime 

 PayUmoney 

 ICICI Pockets 

 Citrus and so on 

 

Digitisation: 

Digitisation, less commonly digitalization the process of converting information into 

a digital (i.e. computer-readable) format, in which the information is organized into bits. The 

result is the representation of an object, image, sound, document or signal (usually an analog 

signal) by generating a series of numbers that describe a discrete set of its points or samples. The 

result is called digital representation or, more specifically, a digital image, for the object, 

and digital form, for the signal. In modern practice, the digitized data is in the form of binary 

numbers, which facilitate computer processing and other operations, but, strictly speaking, 

digitizing simply means the conversion of analog source material into a numerical format; 

the decimal or any other number system that can be used instead. 

Digitization occurs in two parts: 

Discretization: 

The reading of an analog signal A, and, at regular time intervals (frequency), sampling the value 

of the signal at the point. Each such reading is called a sample and may be considered to have 

infinite precision at this stage: 

https://en.wikipedia.org/wiki/Digital_data
https://en.wikipedia.org/wiki/Bit
https://en.wikipedia.org/wiki/Image
https://en.wikipedia.org/wiki/Sound
https://en.wikipedia.org/wiki/Document
https://en.wikipedia.org/wiki/Signal_(electrical_engineering)
https://en.wikipedia.org/wiki/Analog_signal
https://en.wikipedia.org/wiki/Analog_signal
https://en.wikipedia.org/wiki/Sample_(signal)
https://en.wikipedia.org/wiki/Digital_data
https://en.wikipedia.org/wiki/Group_representation
https://en.wikipedia.org/wiki/Digital_image
https://en.wikipedia.org/wiki/Binary_number
https://en.wikipedia.org/wiki/Binary_number
https://en.wikipedia.org/wiki/Decimal
https://en.wikipedia.org/wiki/Number_system
https://en.wikipedia.org/wiki/Sampling_frequency
https://en.wikipedia.org/wiki/Sampling_(signal_processing)
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Quantization: 

Samples are rounded to a fixed set of numbers (such as integers), a process known 

as quantization. 

In general, these can occur at the same time, though they are conceptually distinct. 

A series of digital integers can be transformed into an analog output that approximates the 

original analog signal. Such a transformation is called a DA conversion. The sampling rate and 

the number of bits used to represent the integers combine to determine how close such an 

approximation to the analog signal a digitization will be. 

 

1. Increased Productivity- It takes an employee an average of 12 minutes to find the paper 

document they are looking for. With a well-executed digitalization and document imaging plan, 

this can be reduced to a few seconds or less. 

Document Imaging allows the stake holder ability to share, collaborate, exchange and access 

documents in seconds, reducing the turnaround time further increasing the efficiency for your 

business. 

2. Cost efficiency- The cost of printing and paperwork can be exorbitant. It involves various 

sub costs like equipment management, paper records maintenance and  cost of space. 

Document Imaging with Aptara can help reduce these costs to minimal levels, helping you focus 

on core business areas and increasing the investments for value adding verticals. 

Aptara saves Management Concepts $1M in annual printing, shipping, and labor costs. This 

represents a 100+% return on investment (ROI). 

Companies like Management Concepts, Cisco rely on Aptara for their digitization needs helping 

them to save hundreds of thousand dollars annually in printing, shipping and labor costs. 

3. Easy to access and always accessible- Documents that have been converted can be easily 

accessed through the cloud or system using any device that has internet, anywhere or anytime. 

Optical character recognition: OCR techniques along with proper indexing of the data help in 

searching and accessing the data efficiently saving time and efforts. 

Taxonomy and Indexing: Aptara’s Document Imaging Services will help you build a high level 

classification for your documents so that you can easily find the documents that have been 

scanned Taxonomy is also useful in further refining search results.  A well designed Taxonomy 

will increase your search results and employee adoption. 

4. Enhanced security- A scanned document is tractable document. If needed, only certain users 

can access the documents and workflows can be set up along with permission groups for an 

individual, which enhances the security and maintains the confidentiality of the document. 

5. Enhanced Information Preservation- Information stored in paper formats is degradable 

information, and degrades further every time it is handled manually. Document imaging ensures 

that your business's most important data is saved and preserved for the future. 

6. Document imaging offers you to have a safe repository of your data which can also be 

shared on cloud or your local document management system, enabling you recover precious 

documents with a simple click. 

https://en.wikipedia.org/wiki/Quantization_(signal_processing)
https://en.wikipedia.org/wiki/DA_conversion
https://en.wikipedia.org/wiki/Sampling_rate
http://www.aptaracorp.com/Success_Stories.pdf
http://www.aptaracorp.com/solutions/services/document-imaging-data-capture
http://www.aptaracorp.com/solutions/services/document-imaging-data-capture
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7. Saves space- Real Estate space is expensive, Eliminating paper storage can give you with 

more space, reduction in rent, reduced off-site document storage fees or potential to open up a 

new office. 

8. Stay Competitive- From multinational firms to small organization, digitization has been the 

mantra of the new age document management. Document digitization efforts have repaid 

businesses in reduced costs, efficient workflows and satisfied customers. 

9. Environmentally friendly- Document Imaging and overall document digitizing process 

adds to your green credits and is an environment friendly initiative. It removes the needs of 

creating multiple backup copies and unnecessary printing, increasing the eco-friendly quotient of 

your company. 

10. Digital Transformation – Image scanning is a first step in building a digital transformation 

plan. Early adoption is the key for organizations to ensure digital success  

 

Hot Spot 
A hotspot is a physical location where people may obtain Internet access, typically using Wi-

Fi technology, via a wireless local area network (WLAN) using a router connected to an internet 

service provider. 

Public hotspots may be created by a business for use by customers, such as coffee shops or 

hotels. Public hotspots are typically created from wireless access points configured to provide 

Internet access, controlled to some degree by the venue. In its simplest form, venues that 

have broadband Internet access can create public wireless access by configuring an access 

point (AP), in conjunction with a router and connecting the AP to the Internet connection. A 

single wireless router combining these functions may suffice.  

Private hotspots may be configured on a smartphone or tablet with a mobile network data plan to 

allow Internet access to other devices via Bluetooth pairing or if both the hotspot device and the 

device/s accessing it are connected to the same Wi-Fi network. 

Commercial hotspots 

A commercial hotspot may feature: 

 A captive portal / login screen / splash page that users are redirected to 

for authentication and/or payment. The captive portal / splash page sometimes includes 

the social login buttons. 

 A payment option using a credit card, iPass, PayPal, or another payment service (voucher-

based Wi-Fi) 

 A walled garden feature that allows free access to certain sites 

 Service-oriented provisioning to allow for improved revenue 

 Data analytics and data capture tools, to analyze and export data from Wi-Fi clients 

 

https://en.wikipedia.org/wiki/Internet_access
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Wireless_LAN
https://en.wikipedia.org/wiki/Router_(computing)
https://en.wikipedia.org/wiki/Internet_service_provider
https://en.wikipedia.org/wiki/Internet_service_provider
https://en.wikipedia.org/wiki/Coffeehouse
https://en.wikipedia.org/wiki/Wireless_access_point
https://en.wikipedia.org/wiki/Internet_access
https://en.wikipedia.org/wiki/Wireless_access_point
https://en.wikipedia.org/wiki/Wireless_access_point
https://en.wikipedia.org/wiki/Bluetooth
https://en.wikipedia.org/wiki/Captive_portal
https://en.wikipedia.org/wiki/Authentication
https://en.wikipedia.org/wiki/Payment
https://en.wikipedia.org/wiki/Social_login
https://en.wikipedia.org/wiki/Credit_card
https://en.wikipedia.org/w/index.php?title=IPass_Inc.&action=edit&redlink=1
https://en.wikipedia.org/wiki/PayPal
https://en.wikipedia.org/wiki/Walled_garden_(technology)
https://en.wikipedia.org/wiki/Service-oriented_provisioning
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Software hotspots 

Many Wi-Fi adapters built into or easily added to consumer computers and mobile devices 

include the functionality to operate as private or mobile hotspots, sometimes referred to as "mi-

fi". The use of a private hotspot to enable other personal devices to access the WAN (usually but 

not always the Internet) is a form of bridging, and known as tethering. Manufacturers 

and firmware creators can enable this functionality in Wi-Fi devices on many Wi-Fi devices, 

depending upon the capabilities of the hardware, and most modern consumer operating systems, 

including Android, Apple OS X 10.6 and later, Windows mobile, and Linux include features to 

support this. Additionally wireless chipset manufacturers such as Atheros, Broadcom, Intel and 

others, may add the capability for certain Wi-Fi NICs, usually used in a client role, to also be 

used for hotspot purposes. However, some service providers, such as AT&T, Sprint, and T-

Mobile charge users for this service or prohibit and disconnect user connections if tethering is 

detected. 
 
IOT 
The Internet of things describes the network of physical objects—“things”—that are embedded 

with sensors, software, and other technologies for the purpose of connecting and exchanging data 

with other devices and systems over the Internet. 

Things have evolved due to the convergence of multiple technologies, real-time analytics, 

machine learning, commodity sensors, and embedded systems. Traditional fields of embedded 

systems, wireless sensor networks, control systems, automation (including home and building 

automation), and others all contribute to enabling the Internet of things. In the consumer market, 

IoT technology is most synonymous with products pertaining to the concept of the "smart home", 

including devices and appliances (such as lighting fixtures, thermostats, home security systems 

and cameras, and other home appliances) that support one or more common ecosystems, and can 

be controlled via devices associated with that ecosystem, such as smartphones and smart speakers. 

IoT can also be used in healthcare systems. 

 

There are a number of serious concerns about dangers in the growth of IoT, especially in the areas 

of privacy and security, and consequently industry and governmental moves to address these 

concerns have begun including the development of international standards. 

 

Artificial intelligence: 

Artificial intelligence (AI) is intelligence demonstrated by machines, unlike the natural 

intelligence displayed by humans and animals, which involves consciousness and emotionality.  

 

Features of Artificial Intelligence 

These are the features of AI that make it unique: 

 Eliminate dull and boring tasks 

 Data ingestion 

https://en.wikipedia.org/wiki/Wide_area_network
https://en.wikipedia.org/wiki/Internet
https://en.wikipedia.org/wiki/Bridging_(networking)
https://en.wikipedia.org/wiki/Tethering
https://en.wikipedia.org/wiki/Custom_rom
https://en.wikipedia.org/wiki/Android_(operating_system)
https://en.wikipedia.org/wiki/Apple_OS_X
https://en.wikipedia.org/wiki/Windows_mobile
https://en.wikipedia.org/wiki/Linux
https://en.wikipedia.org/wiki/Atheros
https://en.wikipedia.org/wiki/Broadcom
https://en.wikipedia.org/wiki/Intel
https://en.wikipedia.org/wiki/Network_interface_controller
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 Imitates human cognition 

 Futuristic 

 Prevent natural disasters 

 Facial Recognition and Chatbots 

 

1. Eliminate Dull and Boring Tasks 

All of us have, at some point, accomplished a certain task just because we had to do it, not 

because we enjoyed doing it. We found that task to be boring, or dull. However, with a machine, 

you never have to experience similar boredness. An artificially intelligent system will do and 

continue doing the task as commanded to it, no matter how many times it has to do it. Also, such 

systems only make tedious, vast tasks easier for the users. 

 

2. Data Ingestion 

Data ingestion is one of the most important features of artificial intelligence. Artificially 

intelligent systems deal with huge amounts of data. Even a small company of about 50 employees 

has huge chunks of data to analyze, we can’t even imagine the quantity of data that organizations 

like Facebook handle. 

 

3. Imitates Human Cognition 

We call it an artificially intelligent system because it essentially imitates or mimics the way the 

human mind thinks and solves problems. This is what makes AI unique. Like the humans study 

their environment, draw inferences, and then interact with it accordingly, an AI also successfully 

attempts to interpret the environment and act suitably. 

 

4.Futuristic 

AI-enabled systems are designed to observe and react to their surroundings. They not only 

perceive the environment and take actions accordingly but also keep in mind (isn’t it ironic that I 

just used ‘mind’ for artificial intelligence?) the situations that might come up in the near future. 

 

5. Prevent Natural Disasters 

We are all friendly with using AI for our businesses, for our gaming profiles, and more such 

purposes. Now it is our turn to take AI one step ahead and hone it, so that governments can use it 

in disaster management. Artificially intelligent systems, when fed with data about thousands of 

previous disasters, AI can accurately predict the future relating to the disasters that might occur. 
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